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Document Disclaimer
The information in this document has been carefully checked and is believed to be 
reliable. However, no responsibility can be assumed for inaccuracies that may not have 
been detected. LeCroy reserves the right to revise the information in this document 
without notice or penalty.

Changes or Modifications
Any change or modification not expressly approved by LeCroy voids the user’s authority 
to operate this equipment.

Trademarks and Servicemarks
CATC, USBAdvisor, USBTracer, USBTrainer, USBMobile, USBMobileHS, and 
BusEngine are trademarks of LeCroy. 

Microsoft and Windows are registered trademarks and Windows Vista is a trademark of 
Microsoft Inc.

All other trademarks are property of their respective companies.

Copyright
Copyright © 2007, LeCroy Corporation. All Rights Reserved. This document may be 
printed and reproduced without additional permission, but all copies should contain this 
copyright notice.

FCC Conformance Statement
This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, 
may cause harmful interference to radio communications. Operation of this equipment in 
a residential area is likely to cause harmful interference in which case the user is required 
to correct the interference at his own expense. The end user of this product should be 
aware that any changes or modifications made to this equipment without the approval of 
LeCroy could result in the product not meeting the Class A limits, in which case the FCC 
could void the user's authority to operate the equipment.

EU Conformance Statement
This equipment complies with the EMC Directive 89/336/EEC and the Low Voltage 
Directive 73/23/EEC, and their associated amendments for Class A Information 
Technology Equipment. It has been tested and found to comply with EN55022:1998 
Class A (EN61000-3-2:1998, EN61000-3-3:1995) and EN55024:1998 
(EN61000-4-2:1998, EN61000-4-3:1996, EN61000-4-4:1996, EN61000-4-5:1996, 
EN61000-4-6:1997, EN61000-4-11:1998), and EN60950:1999. In a domestic 
environment this product may cause radio interference in which case the user may be 
required to take adequate measures.
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WEEE Program

 

This electronic product is subject to  
disposal and recycling regulations that  
vary by country and region. Many  
countries prohibit the disposal of  
waste electronic equipment in  
standard waste receptacles. 
For more information about proper  
disposal and recycling of your LeCroy  
product, please visit  
www.lecroy.com/recycle. 
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Chapter 1:  Overview
The LeCroy USBMobileHS™ USB Hi-Speed Analyzer is a portable, PC Card based, bus 
and protocol analyzer that accurately and efficiently debugs, tests and verifies Low, Full, 
and Hi-Speed USB semiconductors, devices, software and systems. USBMobileHS 
features the CATC Trace software, the de facto standard for recording and analyzing 
USB protocol traffic. The CATC Trace simplifies the overall debug process by using 
collapsible, color-coded schemes to represent the USB Packet, Transfer and Transaction 
layers. Its native On-The-Go (OTG) support automatically detects, decodes, and displays 
the HNP and SRP protocols, including VBus pulsing. The USBMobileHS builds upon 
LeCroy's experience and knowledge of the needs of the USB development and test 
communities. The result is a USB bus and protocol analyzer with unprecedented 
functionality, unparalleled flexibility, and uncompromising user friendliness.

Features Benefits

Low power, 16 bit, Type II 
PC Card Design

Personal analyzer. Portable operation with any notebook PC

CATC Trace software 
display

Industry standard speeds up interpretation and debug of USB 
traffic. Compatible with LeCroy USBMobile™, Inspector™, 
Chief™, Advisor™, and USBTracer/Trainer™

OTG (On-The-Go) 
Support

Record and analyze HNP and SRP including the capturing of 
VBus pulses 

Trace Navigator Define areas of interest and "shrink" the viewable Trace to areas 
of most importance

Advanced Triggering Isolate important traffic, specific errors or data patterns 

Hardware Filtering Faster analysis by removing non essential fields from the trace

Intelligent Reporting Quickly identify and track error rates, abnormal bus or timing 
conditions

Sophisticated Viewing View Packet, Transaction and Transfer layers of the USB protocol

Downloadable trace 
viewer software

Share and annotate trace recordings within a development team
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1.1 Event Triggering
For efficient development of USB systems, it is critical that users are able to extract 
important information from a crowded stream of bus traffic, and accurately identify and 
selectively record information that is of most interest. The Events and Action fields for 
trigger set-up is intuitive and graphical, thus making pre-recording set-up time efficient. 

USBMobileHS provides real-time hardware triggering on the critical components of USB. 
Users can custom-configure and control order of events selected for triggering. The count 
and sequence options define the rules for data recording sessions. There are two 
Counters, Filter Out/In and a Restart option that causes sequencing and counting to start 
again. Any sequence can include up to seven events of any type. 

Users can adjust the depth of the recording memory - up to 64 megabytes - and 
determine where in the recording the trigger is located.
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1.2 On The Go Support
The USBMobileHS supports OTG (On-The-Go) capabilities. OTG is an emerging 
standard in the USB specifications that allows peer-to-peer connectivity among USB 
devices and provides a standard USB connection among portable devices. The Analyzer 
identifies both the HNP (Host Negotiation Protocol) and SRP (Session Request Protocol) 
occurrences, searches for Host A or B, and identifies timing anomalies during HNP and 
SRP protocols.
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1.3 The CATC Trace
The CATC Trace's ability to extract critical information quickly and intuitively from a 
crowded stream of bus traffic is unparalleled. The ability to accurately identify and isolate 
very specific packets is vital to speeding debug and development time. Powerful Search 
and Find options allow users to quickly get to specific packets, errors and any data type 
within a trace file. With filter and hide commands, the CATC Trace removes irrelevant 
data from the Trace for efficient viewing. 
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1.4 Features
General
• Fully compliant with USB 2.0 specification
• Supports Full-Speed, Low-Speed, and Hi-Speed USB
• User friendly "CATC Trace™" Interface that displays bus traffic using color and 

graphics
• Trace Viewer available as free non-recording, view-only software
• Three year warranty and hot-line customer support

Physical Components
• PC-Card form factor: Personal analyzer. Low-power, portable operation with any 

notebook PC. 
• Two Mini AB USB ports and cables: Designed to reduce bulk and maintain portabil-

ity and compact size. 
• 64MB of physical recording memory

Recording Options
• Versatile triggering - bit-wise value and mask data patterns up to sixteen bytes wide 

for Setup transactions and data packets.
• Triggering on new High-speed PIDs and split transaction special tokens (ERR, 

SPLIT, PING, NYET, DATA2, and MDATA).
• CATC Trace displays and enumerates High-speed Micro Frames.
• Three forms of triggering: Snapshot, Manual and Event.
• Transaction sequencer allows triggering on a token qualified by a data pattern and 

/or specific handshake or alternately transactions can be filtered (i.e., NAK’d trans-
actions).

• Advanced triggering with event counting and sequencing.
• Triggering on multiple error conditions - PID bad, bit stuffing bad, CRC bad, 

end-of-packet bad, babble, loss of activity, frame length violation, time-out or 
turn-around violation, data toggle violation, Token, Bus Conditions, Data Length, 
excessive empty frames.

• Real-time traffic capture filtering and data packet truncation variable up to 256 
bytes. 

• Adjustable buffer size from 0.4 MB to 64 MB.
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Display Options
• Utilizes the CATC Trace graphical display of bus packets, transactions, split trans-

actions and transfers.
• Numerous packets and transactions can be grouped under a single transfer while 

quickly decoding all essential information.
• Decoding of split transactions up and down stream of a transaction translator is 

accomplished with a special hierarchical view.
• Variety of reports provided to summarize key statistics and conditions of interest 

with the ability to jump to the selected item in the trace display.
• Flexible input signaling can be recorded with the CATC Trace.
• Trace Viewer is backward compatible with USBTracer™, USBMobile™, Advisor™, 

Chief™, Inspector™, and Detective™ trace files.
• User-friendly trigger position indicated by different colors of pre- and post-trigger 

packet color.
• Markers can be set to assist with navigation and time calculations. 
• Hide start-of-frame (SOF) packets as well as any packet or transaction.
• Search for a specific PID.
• Detects and alerts the user to every potential bus error, protocol violation, and com-

binations thereof.
• High resolution, accurate time stamping of bus packets, timing measurement and 

analysis functions.
• Extensive search and packet hiding capabilities.
• Comprehensive device class decoding plus user-defined protocol decoding.

Note:  Refer to Readme.txt on your installation disks for the latest information on 
features. 
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Chapter 2:  General Description
2.1 USBMobileHS System Components

The LeCroy USBMobileHS 2.0 Hi-Speed Protocol Analyzer package includes the 
following items: 

• One LeCroy USBMobileHS Analyzer
• One 1-meter A-B cable (standard A plug to mini B plug)
• One 1-meter A-B cable (mini A plug to mini B plug)
• One 15-centimeter On the Go (OTG) adaptor (standard A receptacle to mini 

A plug)
• LeCroy USBMobileHS software program installation CD
• Product Documentation

2.2 General Description
USBMobileHS™ is controlled through a personal computer PCMCIA slot. It can be used 
with portable computers for field service and maintenance as well as with desktop units 
in a development environment. 

Figure 2.1 USBMobileHS Connection
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USBMobileHS provides on-the-fly detection of and triggering on such events as specific 
user-defined bus conditions, packets matching any Packet Identifier (PID), packets 
matching a Token or Setup transaction, data patterns, and errors and bus conditions. 
Whether recording manually or with a specified Trigger condition, USBMobileHS 
continuously records the bus data in a wrap-around fashion until manually stopped or 
until the Trigger Event is detected and a specified post-Trigger amount of bus data is 
recorded.

Upon detection of a triggering event, the Analyzer continues to record data up to a point 
specified by the user. Real-time detection of events can be individually enabled or 
disabled to allow triggering on events as they happen. This includes predefined exception 
or error conditions and a user-defined set of Trigger events. 

The USBMobileHS software provides powerful search functions that enable investigation 
of particular bus events and allow the software to identify and highlight specific events. 
In addition to immediate analysis, you can print any part of the data. Use the Save As 
feature to save the data on disk for later viewing. The program also provides a variety of 
timing information and data analysis reports.

2.3 Analyzer PC Requirements
The following is a list of recommended configuration for the host machine that runs the 
USBMobileHS application and that is connected to the USBMobileHS Analyzer: 

• Microsoft® Windows® 2000, Windows XP, Windows Vista™ 32, or 
Windows Vista 64 operating system. Note: Support for Windows 2000 will 
end on January 1, 2008. The USBMobileHS application can be used on 
machines with Windows to view trace files. Microsoft Internet Explorer, 
version 5 or newer.

• For optimum performance, use processors of the Intel Pentium III/Pentium 4 
family or the AMD Athlon/Duron family, or other compatible processors with 
clock speed of 500mHz or higher (Processors of the Intel Pentium II/Celeron 
family or AMD K6 family with clock speed of 300mHz or higher are required.)

• For the best performance, it is recommended to have a minimum of 128 MB 
of RAM.

• At least 20 MB of free hard disk space is required for the USBMobileHS 
installation. Additional disk space is needed for storing the recorded data in 
files during the recordings process (can be as much as 50 MB when recording 
a full buffer size).

• Display: Resolution of 1024 x 768 with at least 16-bit color is recommended. 
(Resolution of 800 × 600 with 16-bit color is required.)
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2.4 USB Specification
Please refer to the Universal Serial Bus Specification, version 2.0 for details on the 
protocol. The USB specification is available from the USB Implementers Forum (USB-IF) 
at: 

USB Implementers Forum 
1730 SW Skyline Blvd. Suite 203 
Portland, OR 97221

Tel: +1/503.296.9892 
Fax: +1/503.297.1090 
Web: http://www.usb.org/
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2.5 Specifications
Package

Hardware Interface 

Power Consumption

Environmental Conditions

Recording Memory Size
64 MB

Host Compatibility
The instrument works with any PC equipped with a functioning PCMCIA slot and running 
the Microsoft Windows 2000, Windows XP, Windows Vista 32, or Windows Vista 64 
operating system. Note: Support for Windows 2000 will end on January 1, 2008.

Product Warranty
LeCroy provides a three-year limited warranty on its products.

Dimensions 5.3 x 2.1 x 0.4 inches
(135 x 54 x 5 millimeters)

Weight 1.8 ounces
(51 grams)

Connectors Standard 16-bit Type II PC Card
Mini A-B Receptacles

Idle 500 milliamperes (typical)

Active 560 milliamperes (typical)

Operating Temperature 0 to 55°C (32 to 131°F)

Storage Range -20 to 80°C (-4 to 176°F)

Operating Humidity 10 to 90%, non-condensing

Operating Altitude Up to 6560 feet (2000 meters)
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Chapter 3:  Installation
3.1 USB Test Ports

Connect a host to one of the mini A-B receptacles (use an adaptor if necessary), and 
connect your device to the other. It does not matter which receptacle you plug into.

Note:  The USBMobileHS USB 2.0 Classic Analyzer is not a hub device; it connects 
to a USB branch by inserting a non-intrusive, high impedance tap. Because 
of the poor signal quality in the middle of a USB cable, LeCroy recommends 
using the shortest possible cables so that the total length of both cables 
together is less than 6 feet. The USB cables provided with your Analyzer 
meet this requirement. When longer cables are used, the Analyzer might 
record incorrect data.

3.2 Software Installation
Step 1 Insert the USBMobileHS CD-ROM into your computer.

Step 2 Click Install Software when the Auto-Run program is displayed.

Step 3 Follow the installation instructions on your screen. 

The Install Wizard automatically installs the necessary files to the computer’s hard drive. 
The software is installed in the C:\Program Files\LeCroy\USBMobileHS directory 
unless you specify otherwise. Follow the installation instructions on your screen.
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3.3 Hardware Installation
USBMobileHS components and software are easily installed and quickly ready to run on 
most personal computer systems. You can begin USB recordings after following these 
initial steps. 

Step 1 Insert the CD-ROM.

Step 2 Click NEXT when you see the Add New Hardware Wizard window.

Step 3 Follow the on-screen Plug and Play instructions.

Step 4 Click Finish when you see the message that says "Windows has finished 
installing the software that your new hardware requires" and the file 
USBMobileHS.inf has been installed on your host PC. 

Step 5 Run the program Setup and follow the on-screen instructions.

Launch the LeCroy USBMobileHS program from the LeCroy programs group. 
The main software screen opens: 

Step 6 From the Help menu, select About USBMobileHS. 
If the information below is present, you can record a trace:

• USBMobileHS Software Version
• USBMobileHS Driver Version
• BusEngine™ Version
• Unit Serial Number
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3.4 Your First USB Recording
After installing and launching the software, test USBMobileHS by performing the 
following steps: 

Step 1 Connect a USB cable to each of the two connectors on the USBMobileHS 
module, and then connect the other ends to the USB device under test and USB host 
system.

Step 2 Select Recording Options under Setup on the Menu Bar.

Step 3 Select the General tab to display the default settings such as “Snapshot” and 
1 Mbyte buffer size. For the first recording, leave the settings unchanged. 

Step 4 Click OK to activate the recording options you selected.

Step 5 Turn on the USB devices that are to be tested and cause them to generate USB 
traffic.

Step 6 Click  on the Tool Bar.

USBMobileHS starts to record the USB traffic immediately. After 1 MB of traffic 
has been recorded, the Analyzer uploads the data and displays the packets in 
the trace window.
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Step 7 To terminate the recording before the snapshot automatically 
 
completes, click  on the Tool Bar.

When the recording session is finished, the traffic is uploaded from the Analyzer 
to the hard drive on your PC as a file named data.usb or whatever name you 
assigned as the default filename. While the file is being uploaded, you should see 
a brown progress bar at the bottom of the screen. When the bar disappears, it 
indicates that the data has been uploaded to disk.

Step 8 To save a current recording for future reference, select Save As under File on 
the Menu Bar.

OR

Click  on the Toolbar.

The standard Save As screen appears.

Step 9 Give the recording a unique name and save it to the appropriate directory.

Capturing Your First CATC Trace
After a moment, the recording terminates and the results display. 
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Trace View Features
• The USBMobileHS packet view display makes extensive use of color and 

graphics to fully document the captured traffic.
• Packets are shown on separate rows, with their individual fields both labeled 

and color coded. 
• Packets are numbered (sequentially, as recorded), time-stamped (with a 

resolution of 16.67 ns), and highlighted to show the transmitted speed 
(low-speed or full-speed).

• Display formats can be named and saved for later use. 
• Pop-up Tool Tips annotate packet fields with detailed information about their 

contents
• Data fields can be collapsed to occupy minimal space in the display (which 

can in turn be zoomed in and out to optimize screen utilization). 
The display software can operate independent of the hardware and so can function as a 
stand-alone Trace Viewer that may be freely distributed. 
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Chapter 4:  Software Overview
The USBMobileHS™ software is an application that may be used with or without the 
Analyzer. When used without an Analyzer, the program functions in a Trace Viewer mode 
to view, analyze, and print captured protocol traffic from USBMobileHS Analyzers. The 
software also allows you to view trace files created by the LeCroy USBTracer™, 
USBMobile™, Advisor™, Chief™, Detective™, and Inspector™. Opening a file created 
with any of these Analyzers displays a screen asking if you want to convert the old file to 
the new format under the name convert.usb.

When the program is used with the USBMobileHS Analyzer attached to the computer, 
you can monitor and analyze the activity of your USB branch from either of the USB ports 
on the front of the Analyzer.

4.1 Starting the USBMobileHS Program
To start the USBMobileHS program: 

Step 1 Click Start > Programs > LeCroy > LeCroy USBMobileHS.
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4.2 Tool Tips
Tool tips provide useful information about fields and buttons.

In some cases, tool tips spell out acronyms used in trace fields. In other cases, tool tips 
provide substantial amounts of additional information. To display a tool tip, position the 
mouse pointer over an item.

4.3 Menus
The following table describes the menus within the application. Note that some menus 
are context-sensitive. 

Menu Function
File

Open Opens a file.
Close Closes the current file.
Save As Saves all or a range of packets from the current file.
Print Prints part or all of the current traffic data file.
Print Preview Produces an on-screen preview before printing.
Print Setup Sets the options for the current or new printer.
Edit Comment Creates or edits the Trace file comment field.
Export >
Packets to Text 
(Packet View Format)
Packets to .CSV 
(Comma Separated 
Values for Excel, etc.) 
Format)
Packets to Host Traffic 
Generator Text File 
(.utg)
Packets to Device 
Emulation Traffic 
Generation Text File 
(.utg)
Data

Saves all or part of a trace to a text file or generator file.
Saves trace as text file in Packet View Format.

Saves trace as a comma-separated-values text file for use 
with Microsoft® Excel.

Saves trace as script file that can be used by a Generator to 
generate a trace.

Exports packets to Device Emulation files. This option does 
not export transactions.

Exports Transfer data as text or binary file
Compare Endpoint 
Data

Allows you to select two endpoints of different directions with 
the same address and verify that the data OUT/IN is identical 
to the data IN/OUT from the other endpoint. Used when 
running echo-types of tests for data integrity. 

Import Imports data from a .vcd file.
Exit Exits the USBMobileHS program.
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Setup
Display Options Provides display options such as color, formats, and filters.
Recording Options Provides setup options for recording, triggering events, and 

filtering events.
Record

Start Begins Analyzer recording of USB activity.
Stop Stops Analyzer recording.
Upload Again Allows you to upload a different portion of the captured trace 

if the previous upload was only partially uploaded. 
Manual Trigger Causes a trigger in a trace. Available only in Manual Trigger 

mode. 
Report

File Information Displays information about the recording such as the number 
of packets and triggering setup.

Error Summary Summarizes the errors throughout the recording. Allows for 
fast navigation to packet with errors.

Timing Calculation Calculates timing between two packets and bus utilization.
Traffic Summary Summarizes the numbers and types of errors, packets, 

transactions, split transactions, and transfers that occurred in 
the open trace.

Bus Utilization Displays graphs of packet length, bus usage, and bus usage 
by device.

Search
Go to Trigger Positions the display to show the first packet that follows the 

trigger event.
Go to Packet/ 
Transaction/Transfer.

Positions the display to the packet/transaction/transfer 
number selected in the Go to Packet/Transaction/Transfer 
menu.

Go to Marker » Positions the display to the selected marked packet.
Go to » Positions the display to the selected event, condition, value, 

or type.
Find Allows complex searches on multiple criteria.
Find Next Repeats the previous Find operation.
Search Direction Allows the search direction to be changed from Forward to 

Backward or vice versa.

Menu Function
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View
Toolbars Displays list of available toolbars.
Status Bar Switches display of the Status Bar on or off.
Zoom In Increases the size of the displayed elements.
Zoom Out Decreases the size of the displayed elements.
Wrap Wraps displayed packets within the window.
Hide SOF’s Hides Start of Frames.
Hide NAK’s Hides NAK’ed Transactions.
Hide Devices Hides packets belonging to specified devices by address and 

endpoint.
Hide Chirps Hide the Chirp-K and Chirp-J Bus conditions. These are 

recorded only in USBMobileHS. 
Apply Decoding 
Scripts

Decoding scripts set the values of the display and recording 
options for optimum views of trace information from specific 
vendors or classes of data. This menu option allows you to 
select the vendor or class of data for the request recipients 
and endpoints listed in the Request Recipients and Endpoints 
menu. You can keep the settings across recordings.

Packet Level Displays Packets.
Transaction Level Displays Transactions.
Split Transaction 
Level

Displays Split Transactions.

Transfer Level Displays Transfers.
HWA Segment Level Displays Host Wire Adapter Segments
HWA Transfer Level Displays Host Wire Adapter Transfers
DWA Segment Level Displays Device Wire Adapter Segments
DWA Transfer Level Displays Device Wire Adapter Transfers
PTP Transaction 
Level

Displays PTP Transactions

PTP Object Level Displays PTP Objects
PTP Session Level Displays PTP Sessions
Refresh Decoding Performs a re-analysis and re-decoding of all of the 

transactions in the trace
Window

New Window Switches display of the Tool Bar on or off.
Cascade Displays all open windows in an overlapping arrangement.
Tile Horizontal Arranges multiple trace windows as a series of strips across 

the main display area.
Tile Vertical Displays all open windows in a side-by-side arrangement.

Arrange Icons Arranges minimized windows at the bottom of the display.

Windows ... Displays a list of open windows.

Menu Function
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4.4 View Options
You can hide, display or reset toolbars by selecting View > Tool bars from the menu bar.

Resetting the Toolbars
From time to time (such as following a software upgrade), it is possible for the buttons on 
the toolbar to not match their intended function. You can reset the toolbar by performing 
the following steps:

Step 1 Select View > Toolbars from the menu bar.

Help
Help. Displays online help. You can also select F1.
Help Topics Displays online help.
Update License Opens a dialog box for updating your LeCroy license. 
Display License 
Information

Displays information related to licensing.

About USBMobileHS Displays version information about USBMobileHS.

Menu Function
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Step 2 Select Customize from the submenu to display the Customize dialog box.

Step 3 Select the Toolbars tab to display the Toolbars page of the dialog box. 

Step 4 Click the Reset All button.

The toolbar resets to the factory defaults.
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Tool Bar

The Tool Bar provides quick and convenient access to the most popular program 
functions. Tool tips describe the functionality of each icon and menu item as the mouse 
arrow is moved over the icon/item. 

Open file Hide Chirps

Save As Assign High Level Decodes

Preview Find

Print Find Next

Setup Record Options File Information Report

Setup Display Options Error Report

Start Recording Timing and Bus Usage Calculations

Stop Recording Traffic Summary

Manual Trigger Bus Utilization

Zoom In Open the Navigator bar

Zoom Out Display Packets

Wrap Display Transactions

Hide SOFs Display Split Transactions

Hide NAK’ed transactions Display Transfers

Hide Devices
Display Host Wire Adapter 
Segments
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4.5 Status Bar
The Status Bar is located at the bottom of the main display window. Depending on the 
current activity, the bar can be divided into as many as four segments.

Recording Progress
When you begin recording, the left-most segment of the Status Bar displays a Recording 
Progress Indicator. 

As recording progresses, the Progress Indicator changes to reflect the recording 
progress graphically. In the Progress Indicator, a black vertical line illustrates the location 
of the Trigger Position you selected in Recording Options:

• Pre-Trigger progress is displayed in the field to the left of the Trigger Position 
in the before-Trigger color specified in the Display Options. 

• When the Trigger Position is reached, the progress indicator wiggles as it 
waits for the trigger. 

• After the trigger occurs, the field to the right of the Trigger Position fills in the 
after-Trigger color specified in the Display Options. 

• When recording is complete, the upper half of the progress indicator fills in 
white, indicating the progress of the data upload to the host computer.

You should be aware of two exceptional conditions: 

• If a Trigger Event occurs during the before-Trigger recording, the 
before-Trigger color changes to the after-Trigger color to indicate that not all 
the expected data was recorded pre-Trigger. 

• When you click Stop before or after a Trigger Event, the Progress Bar adjusts 
accordingly to begin uploading the most recently recorded data.

The Progress Bar fills with color in proportion to the specified size and actual rate at which 
the hardware is writing and reading the recording memory. However, the Progress 
Indicator is normalized to fill the space within the Status Bar.

Display PTP Transactions Display Host Wire Adapter Transfers

Display PTP Objects
Display Device Wire Adapter 
Segments

Display PTP Sessions
Display Device Wire Adapter 
Transfers
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Recording Status
During recording, the current Recording Status is displayed in the next segment. When 
you activate the Record function, this segment flashes one of the following messages 
(depending on the selected Recording Options): 

• Trigger?
• Triggered!
• Uploading

After recording stops: 

• The flashing message changes to Uploading data–x% done. (x% indicates 
the percentage completion of the data uploading process.)

• The traffic data is copied to disk into the default file data.usb (or whatever file 
name you have specified in the Recording Options dialog box).

To abort the upload process: 

• Press Esc on your keyboard or click  in the Tool Bar. You are asked if 
you want to keep or discard the partially uploaded data. While uploading is in 
progress, clicking the Stop button again brings up a dialog with four options: 

• Full Buffer/Upload Selection: Allows you to decide how much of the 
buffer to upload. Use the slide bar to set the range to be uploaded.

• Stop: Ends the upload process and preserves whatever part of the 
recording has been uploaded.

• Continue: Resumes the upload process.
• Flush: Empties the uploaded trace from the current file.
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The Partial Upload button is enabled when you have partially uploaded data. When you 
click this button, a dialog box appears that gives you options on what portion of data you 
want to upload again. 

When the data is saved, the Recorded Data file appears in the main display window and 
the Recording Status window is cleared.

• If the recording resulted from a Trigger Event, the first packet following the 
Trigger (or the packet that caused the Trigger) is initially positioned second 
from the top of the display.

• If the recording did not result from a Trigger Event, the display begins with the 
first packet in the traffic file.

Recording Activity
During recording, the fourth segment from the left of the Status Bar displays Recording 
activity as a series of vertical bars. 

The more vertical bars that are displayed, the greater the amount of activity being 
recorded. If there are no vertical bars, there is no recorded activity. 

During uploading, the percent of the completed upload is displayed.

Note:  If packets are filtered from the recording or data are truncated, the recording 
activity is reduced.

Search Status
The rightmost segment displays the current search direction: Fwd (forward) or Bwd 
(backward). Change the search direction from the Search Menu or double-click in the 
Search Status segment. 
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4.6 Navigation Tools
You can zoom in and out, and wrap packets/transactions/transfers to fit within the screen 
using the following buttons:

Zoom In
Zoom In increases the size of the displayed elements, allowing fewer (but larger) packet 
fields per screen. 

• Click  on the Tool Bar.

Zoom Out
Zoom Out decreases the size of the displayed elements, allowing more (but smaller) 
packet fields per screen. 

• Click  on the Tool Bar.

Wrap
Select Wrap to adjust the Trace View so that packets fit onto one line. If a packet is longer 
than the size of the window, the horizontal scroll bar can be used to see the hidden part 
of the packet.

• Click  on the Tool Bar or select Wrap under View on the Menu Bar.
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4.7 USBMobileHS Analyzer Keyboard Shortcuts
Several frequently-used operations are bound to keyboard shortcuts. 

Table 1: Keyboard Shortcuts
Operation Key Combination

Trace Navigation

Find Next F3

Search Backwards Ctrl+B

Search Forwards Ctrl+F

Jump to First Packet Ctrl+Home

Jump to Last Packet Ctrl+End

Go to Any Error Shift+E

Go to Channel 0 Ctrl+Shift+0

Go to Channel 1 Ctrl+Shift+1

View Packets CTRL-1 

View Transactions CTRL-2 

View Split Transactions CTRL-3 

View Transfers CTRL-4 
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PID

Go to ACK Shift+A

Go to DATA0 Shift+0

Go to DATA1 Shift+1

Go to DATA2 Shift+2

Go to DATAx Shift+D

Go to IN Shift+I

Go to MDATA Shift+M

Go to NAK Shift+N

Go to NYET Shift+Y

Go to OUT Shift+O

Go to PING Shift+G

Go to PRE/ERR Shift+P

Go to SETUP Shift+S

Go to SOF Shift+F

Go to SPLIT Shift+X

Go to STALL Shift+L

Bus Conditions

Go to Reset Shift+T

Go to Resume Shift+6

Go to SE0 Shift+Z

Go to SE1 Shift+7

Go to Keep-Alive Shift+5

Go to Suspend Shift+U

Go to Chirp Shift+C

Go to Full Speed J Shift+J

Go to Full Speed K Shift+K
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OTG

Go to SRP Ctrl+Q

Go to HNP Shift+H

Go to VBus Voltage Change Shift+V

Go to OTG Host A Ctrl+Shift+A

Go to OTG Host B Ctrl+Shift+B

Misc.

Marker Menu Ctrl+M

Open File Ctrl+O

Print Ctrl+P

Record Ctrl+R

Stop Recording Ctrl+T

Open Display Options dialog Ctrl+Shift+D

Open Recording Options dialog Ctrl+Shift+R

Hide SOFs Ctrl+Shift+S

Hide NAKs Ctrl+Shift+N

Hide Chirps Ctrl+Shift+C
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Chapter 5:  Reading a Trace
5.1 Trace View Features

• The USBMobileHS™ packet view display makes extensive use of color and 
graphics to fully document the captured traffic.

• Packets are shown on separate rows, with their individual fields both labeled 
and color coded. 

• Packets are numbered (sequentially, as recorded), time-stamped (with a 
resolution of 16.67 ns), and highlighted to show the transmitted speed 
(low-speed, full-speed or high-speed).

• Display formats can be named and saved for later use. 
• Pop-up Tool Tips detail the contents of packet fields.
• Data fields can be collapsed to occupy minimal space in the display and you 

can zoom in and out to optimize screen utilization. 
• The display software can operated independently of the hardware and so can 

function as a stand-alone Trace Viewer that may be freely distributed.
• High Speed SOFs display Microframes (shown below.)

Microframes
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5.2 Set Marker
You can define a unique marker for each packet. 

To place a marker on a packet: 

Step 1 Left-click Packet # for the packet to mark to display the Packet menu: 

Step 2 Select Set Marker to display the Edit Marker Comment window.:

Step 3 Enter a comment about the packet.

Step 4 Click OK.

A marked packet is indicated by a vertical red bar along the left edge of the 
packet # block: 
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5.3 Edit or Clear Marker
To clear or edit the comments associated with a packet marker: 

Step 1 Left-click Packet # to display the Packet menu: 

Step 2 To edit the Marker Comment, select Edit Marker Comment to display the Edit 
Marker Comment window. Edit the comment, then click OK. 

Step 3 To clear a Marker, click Clear Marker.
The vertical red Marker bar disappears.
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5.4 View Raw Bits
You can expand a specific packet to view the raw bits in detail. 

To view the raw bits: 

Step 1 Left-click Packet # to display the Packet menu: 

Step 2 Select Show Raw Bits to display the Raw Bits View for that packet:

Along the top of the Raw Bits View is a linear strip of the logical bit values with 
corresponding field demarcations. Bit stuffing is displayed in color. Below the logical bit 
values is a representation of the D+/D- signaling complete with NRZ encoding. A scroll 
bar assists in navigation of larger packets. Two buttons under the label Packet are used 
to view previous or next packets. Two buttons under the label Zoom allow you to zoom 
in or out on packets.
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5.5 Expanding and Collapsing Data Fields
You can expand a Data field to view it in greater detail or collapse it when you want a 
more compact view. 

Using the Expand/Collapse Data Field Arrows
Data Fields can be easily expanded or collapsed by clicking the small triangular arrows 
on the left side of the data field.

Double-Clicking to Expand/Collapse Data Fields
Data fields can also be expanded or collapsed by double-clicking anywhere in the data 
field.

Expanding or Collapsing All Data Fields
Expand or collapse all data fields by holding down the button for more than a second. 
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Using the Data Field Pop-up Menus
Data fields can expanded or collapsed by clicking in a data field and selecting Expand 
Data or Collapse Data from the pop-up menu.

To expand and collapse data using the menu: 

Step 1 Left-click Data in the Data packet you want to expand or collapse.

If your Data Trace View is currently expanded, you see the Collapse Data menu: 

If your Data Trace View is currently collapsed, you see the Expand Data menu: 

Step 2 Select the desired Expand Data or Collapse Data menu item.

The Trace View is repositioned with the selected packet(s) adjusted in the format 
you have specified.

Expand or Collapse All Data Fields
All data fields can be expanded or collapsed by selecting Expand All Data Fields or 
Collapse All Data Fields from the data field pop-up menus.
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5.6 View Data Block
The data field pop-up menu has an option for viewing the raw bits in a data field. 

To view these bits: 

Step 1 Click in the data field to open the Data Field pop-up menu.

Step 2 Select View Data Block to display the Data Block dialog box.

The View Data Block window has options for displaying the raw bits in different 
formats: 

• Format: Lets you display data in Hex, Decimal, ASCII or Binary 
formats.

• Show Per Line: Lets you control how many bits are displayed per line.
• Bit Order: Most Significant Bit or Least Significant Bit
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5.7 Pop-up Tool-tips
Many trace fields display pop-up tool-tips that provide added details about the field when 
the mouse pointer is suspended over them. 

5.8 Hide SOF Packets
You can hide Start-of-Frame (SOF) packets that may be uninteresting in a given context 
from a Trace View by clicking the Hide SOF Packets button on the Tool Bar:

• Click  to hide all SOF packets.

Note:  If you have enabled 2-Stage SOF Hiding in the General Display Options, 
then the Hide SOF button works in two stages. Click once to hide all SOFs 
that begin frames with no USB traffic. Click twice to hide all SOFs.

5.9 Hide NAKs
You can hide NAKs that may be uninteresting in a given context from a Trace View by 
clicking the Hide NAKs button on the Tool Bar:

• Click  to hide all NAK packets.

5.10 Hide Devices
Click the  button to get a window that allows you to select any address/endpoint 
combination to be hidden. 

5.11 Hide Chirps
Click the  button to hide any Chirped-J or Chirped-K packets recorded in a USB 
trace.
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5.12 Switch to Transactions View
A Transaction is defined in the USB specification as the delivery of service to an 
endpoint. This consists of a token packet, an optional data packet, and an optional 
handshake packet. The specific packets that make up the transaction vary based upon 
the transaction type. 

The program default display mode is Packet View. Before you can view decoded 
transactions, you must switch from Packet View to Transactions View.

To select Transactions View: 

• Click  to on the toolbar.
The Trace View screen is re-drawn to display Transactions. 

Note:  This menu selection displays a check next to Show USB transactions when 
you have selected it. When you want to switch back to Packet View mode, 
right-click anywhere in the trace window and then left-click Show USB 
transactions.
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You can also switch to Transaction View from the Menu Bar: 

Step 1 Select Display Options under Setup to display the Display Options General 
window: 

Step 2 Check Transactions.
Step 3 Click OK.
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5.13 View Decoded Transactions
Once you set Display Options, the Trace View screen is re-drawn to display decoded 
transactions in the colors and format you selected. 

When you instruct the Analyzer to display USB transactions, the components of each 
transaction are collected from the current recording and are grouped and indented below 
each decoded transaction. Each row shows a transaction with a unique numeration, a 
label, and color-coded decoding of important data.
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Expanded and Collapsed Transactions
You can expand a specific transaction to view its parts, which are grouped and indented 
below the transaction. 

To expand a transaction: 

Step 1 Left-click the transaction number you wish to view.

You see the Expand Transaction menu:

Step 2 Select Expand This Transaction.

The screen displays the selected transaction in expanded format.

Note:  The Expand/Collapse transaction feature operates as a toggle: when one 
format is active, the other appears as an option on the Expand/Collapse 
drop-down menu. 

To collapse a transaction, perform the same operation and select Collapse This 
Transaction. 

Note that you can choose to expand or collapse 

• Only the selected Transaction
OR

• All Transactions.
It is not necessary to use the Expand/Collapse Transactions menu to shift between 
expanded and collapsed views of a transaction: 

• Double-click in the Transaction number field to toggle back and forth between 
collapsed and expanded views.
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5.14 Switch to Split Transaction View
To select Split Transaction View: 

Step 1 Click the  button on the toolbar.
The Trace View screen is re-drawn to display Split Transactions.

You can also switch to Split Transactions View from the Menu Bar:

Step 1 Select Display Options under Setup to display the Display Options General 
window: 

Step 2 Check Split Transactions.

5.15 Switch to Transfer View
A Transfer is defined in the USB specification as one or more transactions between a 
software client and its function. USB transfers can be one of four kinds: Control, Interrupt, 
Bulk, and Isochronous. USBMobileHS is capable of displaying all four types.

The default display mode is Packet View. Before you can view decoded transfers, you 
must switch from Packet View (or Transaction View) to Transfer View.

To select Transfer View: 

Step 1 Click  on the toolbar.

The Trace View screen is re-drawn to display Transfers.

Note:  Selecting Show USB transfers adds a check next to this menu item. If you 
want to return to Packet View, open the menu and reselect Show USB 
transfers. This action removes the check and returns the display to Packet 
View.

To switch to Transfer View from the Menu Bar: 

Step 1 Select Display Options under Setup to display the Display Options General 
window: 

Step 2 Check Transfers.
Step 3 Click OK.
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5.16 View Decoded Transfers
Once you set Display Options, the Trace View screen is re-drawn to display decoded 
transfers in the colors and format you selected.

When you instruct the Analyzer to display USB transfers, the components of each 
transfer are collected from the current recording and are grouped below each decoded 
transfer. Each transfer row shows a transfer with a unique numeration, a label, and 
color-coded decoding of important data.

Expanded and Collapsed Transfers
You can expand a specific transfer to view its parts, which are grouped and indented 
below the transfer. 

To expand a transfer: 

Step 1 Left-click the transfer number you wish to view.

You see the Expand Transfer menu:
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Step 2 Select Expand This USB Transfer.
The screen displays the selected transfer in expanded format. 

Note:  The Expand/Collapse transfer feature operates as a toggle: when one format 
is active, the other appears as an option on the Expand/Collapse drop-down 
menu. 

To collapse a transfer, perform the same operation and select Collapse This USB 
Transfer. 
Note that you can choose to expand or collapse:

• Only the selected Transfer
OR

• All Transfers.
It is not necessary to use the Expand/Collapse Transfers menu to shift between 
expanded and collapsed views of a transfers: 

• Double-click in the Transfer number field to toggle back and forth between 
collapsed and expanded views.

5.17 Decoding Protocol-Specific Fields in 
Transactions and Transfers

When transfers or transactions are displayed, the fields in setup transactions or control, 
interrupt, and Bulk transfers by default do not get decoded and are shown in hexadecimal 
values. The exceptions are setup transactions and control transfers for standard USB 
device requests which are always decoded.

In order to show specific decoding for class- and vendor-specific device requests and 
endpoints, you have to use the decoding association mechanism that is described in 
Chapter 9 on decoding. When you have performed the association, you see the 
protocol-specific fields of transfers and transactions decoded in the trace view.
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5.18 Switch to Host Wire Adapter Segment View
A Host Wire Adapter Segment is one or more transfers between a PC and a host wire 
adapter. To view host wire adapter segments, switch to the Host Wire Adapter Segment 
trace viewing level.

To select the Host Wire Adapter Segment trace viewing level: 

• Click  on the toolbar.
OR

• Select View > Show Host Wire Adapter Segment.
OR

• Select Setup > Display Options to display the Display Options window, 
check HWA Segment, and then click OK.

The program redraws the trace view.
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5.19 Switch to Host Wire Adapter Transfer View
A Host Wire Adapter Transfer is one or more wire adapter segments or one or more 
transfers between a PC and a host wire adapter. To view host wire adapter transfers, 
switch to the Host Wire Adapter Transfer trace viewing level.

To select the Host Wire Adapter Transfer trace viewing level: 

• Click  on the toolbar.
OR

• Select View > Show Host Wire Adapter Transfer.
OR

• Select Setup > Display Options to display the Display Options window, 
check HWA Transfer, and then click OK.

5.20 Switch to Device Wire Adapter Segment View
A Device Wire Adapter Segment is one or more transfers between a PC and a device 
wire adapter. To view device wire adapter segments, switch to the Device Wire Adapter 
Segment trace viewing level.

To select the Device Wire Adapter Segment trace viewing level: 

• Click  on the toolbar.
OR

• Select View > Show Device Wire Adapter Segment.
OR

• Select Setup > Display Options to display the Display Options window, 
check DWA Segment, and then click OK.

5.21 Switch to Device Wire Adapter Transfer View
A Device Wire Adapter Transfer is one or more wire adapter segments or one or more 
transfers between a PC and a device wire adapter. To view device wire adapter transfers, 
switch to the Device Wire Adapter Transfer trace viewing level.

To select the Device Wire Adapter Transfer trace viewing level: 

• Click  on the toolbar.
OR

• Select View > Show Device Wire Adapter Transfer.
OR

• Select Setup > Display Options to display the Display Options window, 
check DWA Transfer, and then click OK.
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5.22 Switch to PTP Transactions
The Analyzer supports the Picture Transfer Protocol (PTP) and also supports the 
Media Transfer Protocol (MTP), which is an extension of PTP. The Analyzer can track 
PTP transactions, object transfers, and sessions.

A transaction is a standard sequence of phases for invoking an action. In PTP, an 
Initiator-initiated action provides input parameters, responses with parameters, and 
binary data exchange, and is a single PTP Transaction. Also, a single Asynchronous 
Event sent through the interrupt pipe is a single PTP Transaction. 

The PTP Transaction trace viewing level is the lowest PTP level.

To view PTP transactions, switch to the PTP Transaction trace viewing level:

• Click  on the toolbar.
OR

• Select View > Show PTP Transaction.
OR

• Select Setup > Display Options to display the Display Options window, 
check PTP Transaction, and then click OK.

5.23 Switch to PTP Object Transfers
A logical object on a device has a unique 32-bit identifier (object handle). The 
object handle is also unique for the session (defined below). An object transfer contains 
all the transactions for an object handle. In PTP, all of an object handle’s 
PTP Transactions are a single PTP Object Transfer. 
A PTP Object Transfer can include both PTP Transactions that involve an 
Initiator-initiated action (for example, GetObject, DeleteObject, and GetObjectInfo 
transactions) and PTP Transactions that involve a single Asynchronous Event sent 
through the interrupt pipe. 

The PTP Object Transfer trace viewing level is the middle PTP level.

To view PTP object transfers, switch to the PTP Object Transfer trace viewing level:

• Click  on the toolbar.
OR

• Select View > Show PTP Object.
OR

• Select Setup > Display Options to display the Display Options window, 
check PTP Object, and then click OK.
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5.24 Switch to PTP Sessions
A session is a state of persisting communication between a device and a host during 
which the connection is continuous and the login and other communication parameters 
do not change. A session begins with an OpenSession operation, which establishes the 
communications connection and parameters, and ends with a CloseSession operation. 

A session contains all object transfers (and their transactions), plus all transactions that 
do not belong to object transfers, between an OpenSession operation and a 
CloseSession operation. For PTP, all PTP Object Transfers and all PTP Transactions 
that occur from the OpenSession operation to the CloseSession operation is a single 
PTP Session. 

The PTP Session trace viewing level is the highest PTP level.

To view PTP sessions, switch to the PTP Session trace viewing level:

• Click  on the toolbar.
OR

• Select View > Show PTP Session.
OR

• Select Setup > Display Options to display the Display Options window, 
check PTP Session, and then click OK.
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5.25 Using the Trace Navigator
You can use the Trace Navigator to show the structure of the 
entire trace from different points on the Trace view, thereby 
refining the trace view to a packet range in the trace that is most 
interesting to you. This range can be set by you to show smaller 
parts of the trace. 
 

To display the Navigator bar, click  in the toolbar or select 
the Navigation Bar checkbox in the Display Options General 
window. 

The Navigator bar can be repositioned in the trace and can be 
oriented horizontally or vertically, docked or undocked by 
dragging the parallel bars at the top or side of the Navigator bar. 
By default, the Navigator bar appears vertically to the right of 
the trace window. 

The Navigator bar represents different types of trace 
information in the order of the packets. The top of each bar 
corresponds to the first packet in the trace, and the bottom 
corresponds to the last packet. The Navigator bar is made up 
of three parts: Pre and Post-Trigger traffic, Errors, and 
Types of Traffic. 

At any time, a line in the navigator bar of one pixel in height 
represents a fraction of the trace data. If the Navigation bar is 
400 pixels high, then each bar in this example would represent 
1/400 of the trace. If the trace had 4000 packets total, each bar 
would represent ten packets. In the Types of Traffic portion of 
the navigation bar, the color of the bar would be that of the most 
important item in those ten packets. See “Navigator Bar 
Attributes” on page 52. 

Drag the yellow caret, at the top or bottom, to set the packet 
range. When you move the caret, a message shows the packet 
range.

The blue caret indicates the current packet position in the trace 
view.
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Right-click the Navigator to display the pop-up menu. 

• Pre/Post Trigger, Errors, Types of Traffic: Shows or hides traffic 
information in the Navigator. 

• Legend: Shows or hides Trigger, Error, and Traffic Type categories in the 
Navigator. 

• Set Range to Whole Trace: Resets packet range to the entire trace.
• Set range near packet number: Sets the packet range near the packet 

where your mouse pointer is positioned in the Navigator bar. 
• Recently Used Ranges: Displays a history of ranges that were previously 

selected. 
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Navigator Bar Attributes

The traffic types are shown in order of importance. For example, if a NAK’d transaction 
occurred in the same sample area as a SOF, the NAK would take precedence, and the 
Navigator would show the black bar.

5.26 Edit Comment
You can create, view, or edit the 100-character comment field associated with each 
Trace file. These comments are visible in the Windows® Explorer if the Comments 
attribute is included in the Details view. 

Step 1 Select Edit Comment under File on the Menu Bar to display the Edit comment 
for trace file window:

Step 2 Create, view, or edit the comment.

Step 3 Click OK.

You can view comments in Windows Explorer by selecting the Comments attribute. 
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Chapter 6:  Searching Traces
The Search feature provides methods for searching recorded traffic to find specific 
packets based on triggering status, packet number, marking, or content.

To view the Search options: 

• Click Search in the Menu bar ti display the Search drop-down menu:

6.1 Go to Trigger
Note:  Go to Trigger is enabled only when a trigger has created a traffic file.

To display a Trigger Event: 

• Select Go to Trigger under Search on the Menu Bar.
The Trace View is repositioned to the first packet following the Trigger event. This packet 
is at the top of the screen.



Chapter 6: Searching Traces USBMobileHS User Manual

54 LeCroy Corporation

6.2 Go to Packet/Transaction/Transfer
To display a specific packet: 

Step 1 From the menu bar, select Search > Go to Packet/Transaction/Transfer to 
display the Go to Packet window: 

Step 2 Select the desired viewing level (packet, transaction etc.) from the drop-down 
menu next to the words Go to.

Step 3 Enter the number of the packet you want to display.

Step 4 Click OK.
The Trace View is repositioned with the selected packet at the top of your screen.

6.3 Go to Marker
To instruct the Analyzer to display a marked packet: 

Step 1 Select Go to Marker under Search on the Menu Bar to display a drop-down 
menu listing the marked packets in the Trace View: 

Step 2 Select the desired packet from the displayed list. The Trace View is repositioned 
with the selected packet at the top of your screen.

Note:  The Go to Marker feature functions in conjunction with the Set Marker 
feature. The comments within the parentheses following each marked 
packet are added or edited with the Set Marker feature. Please refer to Set 
Marker in Reading a CATC Trace.

You can use Ctrl+M to go immediately to the All Markers dialog. 
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6.4 Go To
The Go To feature takes you directly to an event in a Trace.

Step 1 Select Go To under Search on the Menu Bar to display the Go To drop-down 
menu: 

Step 2 Select the event you want to go to and enter the necessary information.
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Packet IDs (PIDs)

Select the type of packet to which you want to go.
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ANY Error
Repositions the trace to show the next instance of any error.

Errors
The Errors menu allows you to search for five different types of error: PID, CRC5, 
CRC16, Packet Length, and Stuff Bits. Menu items appear in bold if they are present in 
the trace or are grayed out if not present in the trace, as shown in the example below.

You can press Shift+E to go to the first error of any type. 
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Data Length
Allows you to search for data packets of particular lengths. Lengths are displayed in 
Bytes in a drop down menu as shown below. Selecting a length causes the display to 
move to the next instance of that packet length.

Addr & Endp
The Addr & Endp feature allows you to search for the next packet which contains a 
particular address and endpoint. All available address endpoint combinations are 
displayed in the pull down menu.
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Bus Conditions
Allows you to search by bus conditions such as traffic speed, reset, and suspend. All 
available bus conditions are displayed in the pull down menu.



Chapter 6: Searching Traces USBMobileHS User Manual

60 LeCroy Corporation

Split HubAddr & Port
Allows you to search by Hub Address and port. If present, the option  
More opens a dialog box with a list of addresses and ports. 

On-the-Go
Allows you to search for On-the-go attributes. The On-the-Go menu contains entries for: 

• HNP - Host Negotiation Protocol
• SRP - Session Request Protocol
• Host : A - Hosts with an A plug
• Host: B - Hosts with a B plug 
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Channel
Allows you to search for traffic by 1 (Classic-Speed) or 0 (Hi-Speed).
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6.5 Find
Find allows searches to be conducted on an open trace using one or more criteria. You 
can search by packet, transactions, split transaction, transfer, by packet type and by 
fields within packets. 

Find is run by selecting Search > Find or by clicking  on the toolbar. 

Searches can combine criteria using the options Intersection and Union. Intersection 
creates AND statements such as "Find all packets with x AND y." Union creates OR 
statements such as "Find all packets with x OR y."

You can also perform searches whereby packets or events are excluded from a trace. 
The Exclusion allows searches to be conducted.

To perform a search: 

Step 1 Select Find ... under Search on the Menu Bar

OR

Click  in the Tool Bar to display the User-Defined Find Events screen:

Step 2 Select Packets, Transactions, Split Transactions, Transfers, HWA 
Segments, HWA Transfers, DWA Segments, DWA Transfers, 
PTP/MTP Transactions, PTP/MTP Objects, or PTP/MTP Sessions from the 
top left list box to list that type of event in the Events Group box.

Step 3 Select one or more events from the Events Group box.
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Step 4 Select one of the following options:

• Union: Find all packets matching ANY of the specified events. 

• Intersection: Find packets matching ALL of the specified events. 

• Exclusion: Exclude packets matching any of the specified events. Exclusion 
works with the other two options: Select Union AND Exclusion (=Exclude 
packets with ANY of the following fields) or Intersection AND Exclusion 
(=Exclude packets with ALL of the following fields.) 

Step 5 If desired, set the search Direction and Origin.

Step 6 Click OK.

After the search finishes, the program displays the packets meeting the search criteria.

6.6 Find Next
To apply the previous Find parameters to the next search: 

• Select Find Next under Search on the Menu Bar
OR

• Click  on the Tool Bar.

6.7 Search Direction
Toggles the search forward or backwards. The current direction is indicated in the menu.
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Chapter 7:  Display Options
You can select what information to display in CATC Traces using the Display Options 
window.

To open the Display Options window: 

• Select Display Options under Setup on the Menu Bar.
OR

• Click  on the Tool Bar. 

You can select General, Color/Format/Hiding, and Level Hiding display options. The 
following sections describe these display options.
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7.1 General Display Options
You specify the main Trace View information types and settings using General Display 
Options (see figure on previous page): 

• Zoom Level: Zooms out from 100% (default) to 10% or zooms in from 100% 
to 200%.

• Enable Tips: Pops up text when you position the cursor over a field.
• Wrap: Wraps lines of traffic information instead of truncating lines at the right 

edge of the display.
• Right click cell context menu: By default, clicking the left mouse button on a 

field heading displays a context-sensitive pop-up menu providing commands 
about the field and clicking the right mouse button pops up a menu with 
display options. After selecting this option, clicking the right mouse button on 
a field heading displays the context-sensitive pop-up menu and clicking the 
left mouse button does nothing.

• Hierarchy Lines: Displays lines on the left side of Trace View showing the 
hierarchy from Packets to Transactions to Split Transactions to Transfers if 
you show higher-level decodes.

• Timestamp Position: Aligns the Timestamp field At the beginning (in a 
column on the left side of the Trace View), At the end (in a column on the left 
side of the Trace View), or Merge with Packet/Transaction/Translation. 
Selecting this option allows easier comparison with previous or following 
timestamps.

• Expand Packet Data Fields by default: Displays packet data fields in 
expanded mode. If this option is not selected, packet data fields display in 
collapsed mode, and you can expand them manually.

• Allow any Toggle value after Bus Reset (Int and Bulk Endpoints): 
Depending on the device, after Bus Reset the endpoint toggle state might or 
might not be reset. Selecting this option prevents display of a toggle violation 
error. 

• Expand Script-Based Decoded Info by default: Displays decoded transfer 
fields in expanded mode. If this option is not selected, decoded transfer fields 
display in collapsed mode, and you can expand them manually.

• 2-stage SOF Hiding: You can display all SOFs, hide all SOFs, or hide empty 
SOFs (show only SOFs with endpoint traffic and hide empty frames). 
Selecting this option allows you to hide empty SOFs with one click of the Hide 
SOF button or hide all SOFs with two clicks of the Hide SOF button.

• Use new Std Reqs & Descriptors Scripts: Use dynamically loaded .DEC 
files (rather than .REQ and .DSC files) for decoding Class and Vendor 
requests or endpoints. 
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• Analysis Tools
• Error Report: Displays the Errors section of the Traffic Summary 

window. 
• Timing Calculator: Displays the Timing Calculator window from the 

beginning of a packet or marker to the beginning of another packet or 
marker, including Total Time unit, Bus Utilization Time and Bandwidth, 
and selected Global, Low Speed, Full Speed, High Speed, 
Transactions, and Devices. 

• Traffic Summary: Displays the Traffic Summary window, showing all 
reports, including Packets, Transactions, Transfers, and Errors. 

• Bus Utilization: Displays the Bus Utilization window, including Packet 
length, Bus usage, and Bus usage by device. 

• Navigator: Displays the Navigation bar, including Pre/Post Triggers, 
Errors, and Types of Traffic. 

• Trace Viewing Level: Displays Packets, Transactions, Split Transactions, 
Transfers, Host Wire Adapter Segments, Host Wire Adapter Transfers, 
Device Wire Adapter Segments, Device Wire Adapter Transfers, 
PTP/MTP Transactions, PTP/MTP Objects, and PTP/MTP Sessions.

• Fonts: Sets the font type and bold or italic style for Fields and Data.
• Configuration Name: You can name the current set of Display Options 

values for use with an .opt file. (The options file can have a different name.)
• Restore Factory Presets: Sets all Display Options values to the installed 

values. 
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7.2 Color/Format/Hiding Display Options
To modify the colors, formats, and hiding options, select the Color/Format/Hiding tab. 



USBMobileHS User Manual Chapter 7: Display Options

LeCroy Corporation  69

Color Display Options
The program uses a default set of colors for each type of data in each group of data. The 
colors and color combinations are appropriate for most graphic systems. You can alter 
any color.

To specify a color for an information type, in the Color/Format/Hiding tab, select a row 
(such as Data) in the Group and Color column and expand it. 

Select a data type (such as Data Length) in the Group, then select a color in the Color 
section, using Standard or Custom colors. Use a bright color for each important field.
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To customize colors, use the Custom tab.

Note:  You cannot change the color of an Invalid Data (packet error) field. It is 
permanently set to red.

Formats Display Options
For each type of data in each group of data, the program has a default data format. 
Examples of number data formats are Bin (binary), Dec (decimal), and Hex 
(hexadecimal). Examples of date and time data formats are Hex uFrame, Dec uFrame, 
Date & Time, Time, Bit Time, seconds, microseconds, and nanoseconds. An example of 
a text data format is ASCII. You can alter some data formats.

To specify a data format for an information type, in the Color/Format/Hiding tab, select a 
row (such as Packet Fields) in the Group and Color column and expand it. 



USBMobileHS User Manual Chapter 7: Display Options

LeCroy Corporation  71

Select a data type (such as PID Types) in the Group: 

Select a format in the Format section. The following formats are available for PID Types: 

If available, select Bit Order in the Bit Order section. The options are MSB to LSB or LSB 
to MSB.

Hiding Display Options
By default, no data is hidden. You can hide any group of data and any type of data. You 
can hide transactions, SOFs; NAKs; High, Full, or Low Speed packets; traffic from one or 
both recording channels; and Addresses and Endpoints.

To hide one or more fields, select the Group and Data type in the Group and Color 
column, then click the Hidden checkbox in the display or the Hidden checkbox in the 
Hidden section of the Format section. 
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7.3 Level Hiding Display Options
By default, no data packets, transactions, or bus conditions are hidden. You can hide: 

• Start of Frame packets
• NAK’ed transactions
• Chirp and SEO Bus conditions
• High, Full, or Low Speed packets
• Channel 0 or Channel 1 packets

Select the Level Hiding tab, then select the data types to hide.
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7.4 Saving Display Options
You can save a set of Display Options values, make a set the default settings, or use a 
saved set of values with the commands at the bottom of the Display Options window: 

• To save the current Display Options values in an options file for use in future 
sessions, click Save. Enter a file name without a file name extension. The 
program adds the .opt extension. (The file must have an .opt file name 
extension.)

• To load a previously saved .opt file, click Load and select a file name.
• To save the current Display Options values in the default.opt options file for 

use as the default display options, click Save as Default. (Do not delete the 
default.opt file.)

• To apply the current Display Options values, click Apply. The Display Options 
window remains open.

• To apply the current Display Options values and close the Display Options 
window, click OK.

• To cancel unsaved changes to display values and exit the Display Options 
window, click Cancel. 
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Chapter 8:  Decode Requests
8.1 Class and Vendor Definition Files

LeCroy Analyzers use script files to decode class and vendor requests. The script files 
are read when the application is initialized. After reading, the Analyzer decodes class and 
vendor requests as instructed by the files.

.DEC files represent the new method of decoding. DEC stands for "decoder" and 
describes both Class and Vendor requests in a C-like language. Each .dec file stores an 
endpoint or request decode. When the application starts, these files are loaded 
dynamically. Subdirectories are supported. 

For information about legacy script decoding, see Appendix A “Legacy Script Decoding” 
on page 125.

Note: The .dec files listed in the following table are in the Scripts directory under the 
installation directory: 

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID

Audio Class decoding 2.0
     AudioClass\Audio1.0Requests.dec
     AudioClass\Audio2.0Requests.dec

Audio 01h

Communications and CDC Control
Direct Line Control Model
Abstract Control Model
Telephone Control Model
Multi-Channel Control Model
CAPI Control Model
Ethernet Networking Control Model
ATM Networking Control Model
Wireless Handset Control Model
Device Management Model
Mobile Direct Line Model
OBEX Model
Communication Device Subclass/EEM
     Communications\CommRequests.dec
     Communications\CommInterrupt.dec
     Communications\CommCDCEEM.dec

CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID
CCID

02h
02h
02h
02h
02h
02h
02h
02h
02h
02h
02h
02h
02h

01h
02h
03h
04h
05h
06h
07h
08h
09h
0Ah
0Bh
0Ch
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HID (Human Interface Device)
HUT (HID extension)
Monitor (HID extension)
Physical Interface  
     (force-feedback extension to HID)
Point of Sale Devices (HID extension)
Power (HID extension)
     Hid\hid.dec
     Hid\Hid_Req.dec

HID
HID
HID
HID 

HID
HID

03h
Extension
Extension
Extension 

Extension
Extension

  

Physical
     Hid\hid.dec
     Hid\Hid_Req.dec

HID 05h

Still Imaging Class
     StillImageClass\PTPStillImageBulkIn.dec
     StillImageClass\PTPStillImageBulkOut.dec
     StillImageClass\PTPStillImageRequests.dec
     StillImageClass\PTPStillInterrupt.dec

PTP
   Still Image

06h 01h 01h

Printer
     Printer\Printer_req.dec

Printer 07h 01h xxh

Mass Storage Mass Storage 08h

SCSI/Bulk Protocol
     MassStorageClass\MS_BulkOnly_Requests.dec
     MassStorageClass\MS_BulkOnlySCSIInEndpoint.dec
     MassStorageClass\MS_BulkOnlySCSIOutEndpoint.dec
     MassStorageClass\MS_BulkOnlySCSIOutEndpoint.dec

Mass Storage
   SCSI Bulk

08h 06h 50h

UFI (floppy)/CBI Protocol
     MassStorageClass\MS_UFI_CBI_Requests.dec
     MassStorageClass\MS_UFI_CBI_BulkInEndp.dec
     MassStorageClass\MS_UFI_CBI_BulkOutEndp.dec
     MassStorageClass\MS_UFI_CBI_InterruptEndp.dec

MassStrg Class
   UFI CBI

08h 04h 00h

Hub support
     HubClass\HubClassRequests.dec
     HubClass\HubClassStatusEndpoint.dec

Hub Class 09h

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID
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Picture Transfer Protocol (PTP)
[Photographic and Imaging Manufacturers
Association (PIMA) 15740 and ISO 15740]
     StillImageClass\PTPStillImageBulkIn.dec
     StillImageClass\PTPStillImageBulkOut.dec
     StillImageClass\PTPStillImageRequests.dec
     StillImageClass\PTPStillInterrupt.dec

PTP
   Still Image

Extension

Communications Device Class (CDC) Data
     Communications\CDCDataBulkIn_wCTE.dec
     Communications\CDCDataBulkIn_wPW.dec
     Communications\CDCDataBulkIn_wPW_wCTE.dec
     Communications\CDCDataBulkOut_wCTE.dec
     Communications\CDCDataBulkOut_wPW.dec
     Communications\CDCDataBulkOut_wPW_wCTE.dec
     Communications\CDCDataIsochIn_wCTE.dec
     Communications\CDCDataIsochIn_wPW.dec
     Communications\CDCDataIsochIn_wPW_wCTE.dec
     Communications\CDCDataIsochOut_wCTE.dec
     Communications\CDCDataIsochOut_wPW.dec
     Communications\CDCDataIsochOut_wPW_wCTE.dec

0Ah 00h

Smart Card (CCID)
     SmartCard\CCIDBulkIn.dec
     SmartCard\CCIDBulkOut.dec
     SmartCard\CCIDInterrupt.dec
     SmartCard\CCID_req.dec
     SmartCard\ICCDBulkIn.dec
     SmartCard\ICCDBulkOut.dec
     SmartCard\ICCDInterrupt.dec
     SmartCard\ICCD_req_Ver.A.dec
     SmartCard\ICCD_req_Ver.B.dec

CCID and ICCD 0Bh

Video Class (UVC) decoding 1.1 (currently at 1.0)
VIDEO CONTROL
VIDEO STREAMING
VIDEO INTERFACE COLLECTION
     VideoClass\VideoBulkIn.dec
     VideoClass\VideoBulkOut.dec
     VideoClass\VideoInterrupt.dec
     VideoClass\VideoIsochIn.dec
     VideoClass\VideoIsochOut.dec
     VideoClass\Video1.0Requests.dec
     VideoClass\Video1.1Requests.dec

Video
Video
Video

0Eh
0Eh
0Eh
0Eh

01h
02h
03h

00h
00h
00h

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID
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You can create your own .dec file for a Class or Vendor Request. For more information 
on the format of these Script Decoder files and the Script Decoding language, read the 
Script Decoder Manual.

Wireless Controller
BT
UWB
Remote Network Driver Interface Specification (RNDIS)
Host Wire Adapter
Device Wire Adapter
Device Wire Adapter Isochronous interface
     WireAdapter\WA_DataInEndpoint.dec
     WireAdapter\WA_DataOutEndpoint.dec
     WireAdapter\WA_NotifEndpoint.dec
     WireAdapter\WA_Requests.dec
     WireAdapter\WA_Radio_Requests.dec
     WireAdapter\WA_RadioNotifEndpoint.dec

HCI
WA Radio Control
Remote NDIS
Wire Adapter Class
Wire Adapter Class
Wire Adapter Class

E0h
E0h
E0h
E0h
E0h
E0h
E0h

01h
01h
01h
02h
02h
02h

01h
02h
03h
01h
02h
03h

Miscellaneous Device Class
Interface Association Descriptor 
 

Wire Adapter Multifunction 
     Peripheral programming interface
Cable Based Association Framework (CBAF) Requests 

     Standard\StandardRequests.dec
     IEEE\IEEECompanies.dec
     Virtual\VirtualDATAIn.dec
     Virtual\VirtualDATAOut.dec
     Virtual\VirtualUARTIn.dec
     Virtual\VirtualUARTOut.dec
     AssociationFrameworks\  
          WUSB_CableBasedAssociation.dec

IrDA Bridge
ATAPI
IP
HTTP

Standard,  
   so no decoder 
   method needed
Wire Adapter Class 

Association 
   Frameworks

 

IrDA Bridge
ATAPI
IP
HTTP

EFh
EFh 
 

EFh 

EFh 

 

FEh
08h

02h 
 

02h 

03h 

 

02h
02h

01h 
 

02h 

01h 

 

00h
50h

USB Decode USB
Decoder
Name

USB-IF

Base
Class

Codes

Sub
Class

Proto-
col
ID
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8.2 Class/Vendor Decoding Options
You can permanently assign a class or vendor decoding for an address and/or endpoint 
or interface in a trace file. Once assigned, the decoding occurs automatically when you 
display transactions.

Mapping Request Recipient to Class/Vendor Decoding
To assign a decoding group to a request recipient, 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Control Transfer field to display the USB Device Request menu:

Step 2 Select Map Request Recipients to Class/Vendor Decoding to display the 
Request Recipient and Endpoints dialog box: 

The Recipient field shows all Class and Vendor Request Recipients found in the 
trace file. The display shows the Host, Address, and Type (Class or Vendor) for 
the recipient. On the right are the names of Class/Vendor Decoding groups 
currently assigned to recipients. If blank, no decoding is assigned for a recipient. 

Step 3 Select a recipient.
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Step 4 Display the Class/Vendor Decoding Groups drop-down menu.

The drop-down menu lists the defined Class/Vendor request decoding groups. 
The Class/Vendor Decoding Groups are:

• No Decoding
• Audio Class Requests
• Communication Class Requests
• HCI Command
• HID Class
• HID Class Requests
• Hub Class Requests
• Mass-Strg Bulk-Only Requests
• Mass-Strg Class UFI CBI Requests
• Printer Class Requests
• Standard Requests
• Still Image/PTP/MTP/PictBridge Class Requests
• Video Class Requests
• Wire Adapter Radio Control Requests
• Wire Adapter Class Requests

Step 5 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 6 Repeat the previous steps for additional recipients.

Step 7 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.

Step 8 Click OK.
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Mapping Endpoint to Class/Vendor Decoding
To assign a Class/Vendor Endpoint decoding, 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Bulk/Int Transfer field to display the USB Device Request menu.

Step 2 Select Map Endpoint to Class/Vendor Decoding to display the Request 
Recipients and Endpoints dialog box.

Step 3 Click the Endpoints tab to display the Endpoints dialog box. 

The Endpoint field (Endp) shows all Endpoints found in the trace file. The 
displays shows the Host, Address, and Direction for the recipient. On the right 
are the names of Class/Vendor Endpoint Decoding groups currently assigned to 
endpoints. If blank, no decoding is assigned for a recipient. 

Step 4 Select an endpoint.
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Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu: 

The Class/Vendor Endpoint Decoding options for an OUT endpoint are: 

• No Decoding
• CCID Bulk Out Message
• Display DATA
• HCI data out
• HCI SCO out
• Mass Strg Bulk-Only SCSI Out Endp
• Mass Strg UFI_CBI Bulk Out Endp
• Still Image/PTP/MTP/PictBridge Bulk Out
• Video Bulk Out
• Video Isoch Out
• Virtual UART
• Wire Adapter Data Transfer Out Endp
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The Class/Vendor Endpoint Decoding options an IN or Interrupt endpoint are: 

• No Decoding
• CCID Bulk In Message
• Communication Class Interrupt Notification
• Display DATA
• HCI data in
• HCI event
• HCI SCO in
• HID In Endp
• Hub Class Status Change Endp
• Mass Strg Bulk-Only SCSI In Endp
• Mass Strg CBI Interrupt Endp
• Mass Strg UFI_CBI Bulk In Endp
• Mass Strg UFI_CBI Interrupt Endp
• Still Image/PTP/MTP/PictBridge Bulk In
• Still Image/PTP/MTP/PictBridge Interrupt
• Video Bulk In
• Video Interrupt
• Video Isoch In
• Virtual UART
• Wire Adapter Radio Notif Endp
• Wire Adapter Data Transfer In Endp
• Wire Adapter Notif Endp

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional endpoints you would like to map.

Step 8 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.

Step 9 Click OK.
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Mapping Request RPipe to Class/Vendor Decoding
Before mapping Request RPipes to Class/Vendor Decoding, you must first assign the 
following endpoint decoders:

• Wire Adapter Data Out
• Wire Adapter Data In
• Wire Adapter Notif

To assign a decoding group to a Request RPipe: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Control Transfer field to display the USB Device Request menu. 

Step 2 Select Map RPipe to Class/Vendor Decoding to display the Request Recipient 
and Endpoints dialog box.

Step 3 Click the Request RPipes tab to display the Request RPipes dialog box:

The Recipient field shows all Class and Vendor Request recipients found in the 
trace file. The RPipe field shows all Class and Vendor Request RPipes found in 
the trace file. The displays shows the Otg Host, HWA address, and Type (Class 
or Vendor) for the recipient. On the right are the names of Class/Vendor 
Decoding groups currently assigned to recipients. If blank, no decoding is 
assigned for a recipient. 

Step 4 Select a recipient.

Step 5 Display the Class/Vendor Decoding Groups drop-down menu. The 
Class/Vendor Decoding Groups are the same as for Request Recipients.

Step 6 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for additional recipients.

Step 8 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.

Step 9 Click OK.
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Mapping Endpoint RPipe to Class/Vendor Decoding
To assign a Class/Vendor Endpoint RPipes decoding: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Bulk/Int Transfer field to display the USB Device Request menu.

Step 2 Select Map Endpoint RPipe to Class/Vendor Decoding to display the Request 
Recipients and Endpoints dialog box.

Step 3 Click the Endpoint RPipes tab to display the Endpoint RPipes dialog box: 

The RPipe field shows all RPipes found in the trace file. The displays shows the 
Otg Host, HWA address, and Direction for the recipient. On the right are the 
names of Class/Vendor Endpoint Decoding groups currently assigned to 
endpoints. If blank, no decoding is assigned for a recipient.

Step 4 Select an endpoint RPipe.

Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu. The 
Class/Vendor Endpoint Decoding options are the same as for Endpoints.

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional RPipes you would like to map.

Step 8 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.

Step 9 Click OK.
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Mapping Request DWA RPipe to Class/Vendor Decoding
Before mapping Request DWA RPipes to Class/Vendor Decoding, you must first assign 
the following endpoint decoders:

• Wire Adapter Data Out
• Wire Adapter Data In
• Wire Adapter Notif

To assign a decoding group to a Request RPipe: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Control Transfer field to display the USB Device Request menu. 

Step 2 Select Map DWA RPipe to Class/Vendor Decoding to display the Request 
Recipient and Endpoints dialog box.

Step 3 Click the Request DWA RPipes tab to display the Request DWA RPipes dialog 
box:

The Recipient field shows all Class and Vendor Request recipients found in the 
trace file. The RPipe field shows all Class and Vendor Request RPipes found in 
the trace file. The displays shows the Otg Host, HWA address, and Type (Class 
or Vendor) for the recipient. On the right are the names of Class/Vendor 
Decoding groups currently assigned to recipients. If blank, no decoding is 
assigned for a recipient. 

Step 4 Select a recipient.

Step 5 Display the Class/Vendor Decoding Groups drop-down menu. The 
Class/Vendor Decoding Groups are the same as for Request Recipients.

Step 6 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for additional recipients.

Step 8 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.
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Step 9 Click OK.

Mapping Endpoint DWA RPipes to Class/Vendor Decoding
To assign a Class/Vendor Endpoint DWA RPipes decoding: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Bulk/Int Transfer field to display the USB/WUSB Device Request 
menu.

Step 2 Select Map Endpoint RPipe to Class/Vendor Decoding to display the Request 
Recipients and Endpoints dialog box.

Step 3 Click the Endpoint RPipes tab to display the Endpoint RPipes dialog box: 

The RPipe field shows all RPipes found in the trace file. The displays shows the 
Otg Host, HWA address, and Direction for the recipient. On the right are the 
names of Class/Vendor Endpoint Decoding groups currently assigned to 
endpoints. If blank, no decoding is assigned for a recipient.

Step 4 Select an endpoint DWA RPipe.

Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu. The 
Class/Vendor Endpoint Decoding options are the same as for Endpoints.

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional RPipes you would like to map.

Step 8 To retain a mapping from trace to trace DURING an application session, select 
the Keep Across Recordings checkbox.

Step 9 Click OK.
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8.3 General Options
Commands are transferred on USB using special control transfers called USB Device 
Requests. The Analyzer can decode Device Requests as they are defined in the USB 
specifications and various Device Class and Vendor specifications.

Each USB Device Request is sent using a Control Transfer. Each Control Transfer starts 
with a SETUP transaction.

Decoding USB Device Requests
To decode a USB Device Request: 

Step 1 Left-click the Control Transfer field or the SETUP field of the 
USB Device Request to display the USB Device Request menu: 

Note:  The menus shown in this section are context-sensitive. You may see slightly 
different menus. 

Step 2 To refresh decoding, click Refresh Decoding for this Trace File. Use this option 
to reanalyze all transactions. 

Step 3 To use the previous decoding, click Load most recent decoding mapping. 

This option loads the most recent mapping of endpoints/requests to decoding 
types that was done on a previous trace. If the endpoints of the new trace are the 
same as the last one mapped, the mappings are applied to the current trace. This 
saves the user from having to constantly apply the mapping to a new trace every 
time the application is restarted and a new trace created. 

The ability to retain the mapping from trace to trace DURING an application 
session already exists: the Keep Across Recordings button in the endpoint map 
dialog. This new feature simplifies the process when the application has been 
re-started. 

Note:  You can also change the format, color, and hidden status of fields, using the 
same methods as in Display Options. (See Chapter 6, Display Options.)



USBMobileHS User Manual Chapter 8: Decode Requests

LeCroy Corporation  89

Decoding Standard Requests
To decode a standard request: 

Step 1 From the USB Device Request menu, select Decode Standard Request to 
display the View Fields for Standard Request text box: 

Step 2 To find a word in the text box, click the Find button. Enter the word in the Find 
What field. To use a case-sensitive search, check Match Case. To find only the 
exact word, check Match Whole Word Only. You can search Up or Down. To 
search, click Find Next.

Step 3 To save the View Fields text box as an HTML file, click the Save As button, enter 
a file name in the Save As dialog box, then click Save.

Step 4 To view the previous or next Transfer Control field request of the same request 
type, click Previous or Next.

The View Fields for Standard Request dialog box displays field definitions and values of 
the Standard Request. 
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For field definitions, please refer to the Universal Serial Bus Specification, version 2.0. 
The USB specification is available from the USB Implementers Forum (USB-IF) at: 

Decoding Class Requests
Examples of a class request are Mass-Strg Class UFI CBI Requests, 
PTP Still Image Class Requests, Video Class Requests, and Wire Adapter Class 
Requests. 

To decode a class request: 

Step 1 From the USB Device Request menu, select Decode ... Request to display the 
View Fields for ... Class Requests text box.

The following figure shows a Wire Adapter Class Requests decoding:

Decoding Vendor Requests
To decode a vendor request: 

• From the USB Device Request menu, select Decode ... Request to display 
the View Fields for ... Vendor Requests text box.

An example of a vendor request is USBMobileHS™ Command Set. 

Decoding Undefined USB/WUSB Device Requests
A Decoding Request may not belong to any of the defined decoding groups (Standard, 
Class, or Vendor).

USB Implementers Forum 
1730 SW Skyline Blvd.  
Suite 203 
Portland, OR 97221

Tel: +1/503.296.9892 
Fax: +1/503.297.1090 
Web: http://www.usb.org/
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Decoding using Endpoint Information
To decode using the endpoint information: 

Step 1 Left-click the Bulk/Int Transfer field to display the Bulk/Int Transfer (IN/OUT 
transaction with data) menu.

Step 2 Select Decode as ... Endp to open a View Fields for ... Endp text box.

The following figure shows a Wire Adapter Data Transfer Out Endp decoding: 

Changing the Layout of Decode Requests
In the View ... Fields windows, the Decoding Information and the Descriptor information 
blocks (following the Request Summary information) have the following columns:

• Field: such as bRequest, wValue, wIndex, bLength, bDescriptorType, 
wTotalLength

• Length in bits
• Offset in bits
• Decoded: hex value typically equal to Hex Value
• Hex Value: hex value typically equal to Decoded
• Description: short description of field
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To change the layout of decode requests display: 

Step 1 Click Layout to display the View ... Fields Dialog Layout dialog box: 

Figure 8.1 View WUSB Xfer Fields Dialog Layout Dialog Box

Step 2 To display the available columns of data, use the checkboxes for Length, Offset, 
Decoded, Hex Value, and Description.

You can Check All or Uncheck All.

Step 3 To show only the fields of Collapsed mode, check Show only fields specified 
for view in collapsed mode.

Step 4 To retain settings for future viewing of Decode Request fields, check Use these 
settings when View Fields dialog opens.
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Chapter 9:  Reports
The Report menu provides several reports to assist you in analyzing USB traffic recorded 
by the Analyzer.
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9.1 File Information
To display a File Information report: 

• Select File Information under Report in the Menu Bar.
OR

• Click  in the Tool Bar to display the File Information screen: 

The File Information report provides information about how the recording was made, 
what the buffer settings were, what the trigger options were, and what version of all the 
Analyzer hardware was used to make the recording.



USBMobileHS User Manual Chapter 9: Reports

LeCroy Corporation  95

9.2 Error Summary
The Error Summary details all errors analyzed throughout the recording.

• Select Error Summary under Report in the Menu Bar.
OR

• Click  in the Tool Bar to display the Error screen below the Trace View: 
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9.3 Timing Calculations
The Timing Calculator is used to measure timing between any two packets.

• Select Reports > Timing Calculations in the Menu or click  to display 
the Timing and Bus Usage Calculator screen: 
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9.4 Traffic Summary
Traffic Summary summarizes the numbers and types of packets, transactions etc. that 
occurred in the open trace.

To run Traffic Summary, select Report > Traffic Summary or click the button 
marked . The program prompts you to specify a range of packets, then displays the 
following window: 
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9.5 Bus Utilization
The Bus Utilization window displays information on bandwidth use for the three 
recording channels. 

To open the Bus Utilization window, select Report > Bus Utilization
or click the button marked . A window opens with graph areas: 
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Bus Utilization Buttons
The Bus Utilization window has a row of buttons for changing the format of the displayed 
data and for exporting data:

The buttons have the following functions: 

Save As - Saves the graphs as a 
bitmap file (*.bmp) Vertical zoom in

Email - Creates an email with a 
*.bmp file attachment of the graphs Vertical zoom out

Print
Click and Drag zoom - Click 
diagonally to select and zoom in on 
part of the graph

Full Screen Select Range

View Settings - opens a sub-menu 
with options for formatting the 
display. See “Clicking the View 
Settings button  opens a menu with 
options for formatting the display.” 
below.

Sync and Graph areas - If two or 
more graphs are displayed, this 
button synchronizes the graphs to 
one another. Once synchronized, the 
positioning slider of one graph 
moves the other graphs

Horizontal zoom in
Graph Areas - Presents options for 
displaying additional graphs of data 
lengths, packet lengths, and 
percentage of bus utilized.

Horizontal zoom out
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View Settings Menu
Clicking the View Settings button  opens a menu with options for formatting the 
display. 

• Orient Horizontally: Changes the orientation of bus usage to horizontal. 
After selecting this option, the menu has Orient Vertically.

• Tile Vertically: Tiles the two graphs vertically (i.e., side by side). After 
selecting this option, the menu has Tile Horizontally.

• Show Markers: Places tick marks along the x axis of each graph.
• Show Plumb Line
• Status: Opens a sub-menu with the following options: 

• Bar: Displays a status bar at bottom of graph.
• Tooltip: Causes a tooltip to appear if you position your mouse pointer 

over part of the graph and leave it there for a couple of seconds.
• None: Turns off tooltips and the status bar.

• Grid Lines: Opens a sub-menu with the following options: 
• Both: Displays both X and Y axis gridlines
• X Axis: Displays X axis gridlines
• Y Axis: Display Y axis gridlines
• None: Turns off gridlines

• Grid on Top: Moves the grid lines above the graph.
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• Fonts and Colors: Opens a dialog box for setting the colors and fonts used in 
the graphs: 



Chapter 9: Reports USBMobileHS User Manual

102 LeCroy Corporation

Graph Areas Menu
The Graph Areas menu allows you to view different information in the Bus Utilization 
window. 

Step 1 Click the  button to display the Graph Areas menu. 

Step 2 Select the data to appear in the Graph Areas window. 

Step 3 To make a new graph, click New.

To change the properties in the Bus Utilizations graph: 

Step 1 In the Graph Areas menu, select what you want your graph to display, then click 
OK.

Step 2 To make a new graph, click New.
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Chapter 10:  Recording Options
Use Recording Options to create and change various features that control the way 
information is recorded by the USBMobileHS™ Analyzer. 

To open the Recording Options menu: 

• Select Recording Options under Setup on the Menu Bar
OR

• Click  on the Tool Bar.
You see the Recording Options window at the General tab: 
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10.1 General Recording Options
The General Recording Options allow you to select or adjust the recording type, the 
buffer size, the amount of post-trigger recording, and the trace filename and path.

Recording Type
The Recording Type box presents three options that allow you to set how USBMobileHS 
begins and ends a recording. 

The options are: Snapshot, Manual Trigger, and Event Trigger.

Snapshot
A Snapshot is a fixed-length recording whose size is determined by the Buffer Size box 
in the Recording Options dialog. 

Recording begins when  is clicked and ends when the buffer is full. 

You can stop recording by clicking the  Stop button. 

Manual Trigger
A Manual Trigger is a recording whose trigger point is caused by pressing the trigger 
button on the front panel.

Recording begins when you click  on the Tool Bar. Recording continues in a circular 
manner within the limits set by the buffer size. 

Recording ends when  is clicked on the Tool Bar or after post-trigger memory has 
been filled following depression of the trigger button on the front panel.

Event Trigger
Recording begins when you click  on the Tool Bar.

Recording continues in a circular manner within the limits set by the buffer size until an 
event is detected that meets the Trigger conditions specified in the Triggering Options 
and the defined amount of data has been recorded after the Trigger Event.

Options
Truncate Data Fields allows data fields to be truncated during recording to save 
Analyzer memory and allow recording of more packets. Enter a minimum data length 
value in the Bytes box. USBMobileHS truncates the data to the stated value or slightly 
larger.

Note:  Truncation of data may cause incorrect transaction or transfer decoding.

Beep When Trigger Occurs causes the computer connected to the USBMobileHS to 
beep three times when a trigger condition is first detected.
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Buffer Size
You can adjust the size of the recording buffer from 0.4 megabytes to 64 megabytes. 

The Recording type option determines how this buffer is used. Although there are 64 
megabytes of physical memory in the Analyzer, the efficiency of the recording is about a 
2:1 ratio of physical memory to actual USB traffic. Shorter USB packets yield a slightly 
less efficient recording. The non-traffic portion of physical memory is utilized for control 
and timing information.

Note:  The scale is not linear and affords more granularity in the smaller buffer 
sizes. 

Trigger Position
You can adjust the amount of recording to be done post-Trigger or select where you want 
the Trigger located within the defined buffer. You can adjust the Triggering Position 
between 1 and 99% post-Trigger. Trigger Position is available only when Manual 
Trigger or Event Trigger is selected as Recording type.

As an example, if the buffer size is set to 16MB, then for the following Trigger Position 
settings, the amount of pre- and post-Trigger data is: 

• 95% post-triggering: 0.8MB pre-trigger, 15.2MB post-trigger
• 75% post-triggering: 4MB pre-trigger, 12MB post-trigger
• 50% post-triggering: 8MB pre-trigger, 8MB post-trigger 
• 25% post-triggering: 12MB pre-trigger, 4MB post-trigger
• 5% post-triggering: 15.2MB pre-trigger, 0.8MB post-trigger

Note:  When a Trigger occurs, recording continues until the post-Trigger amount of 
the buffer is filled or when Stop is selected.

Options Name
The Options Name is a descriptive label of the current Recording Options settings. 
Options Names are associated with files that have a .rec suffix. 

The default option name is default. Default preserves the current Recording Options 
settings.

The purpose of the Options Name box is to give you a place to preserve different 
Recording Options that you use on a recurrent basis. For example, if you use two or three 
different Recording Options configurations, you can save these configurations and load 
them the next time they are needed.

Because Options Names are descriptive labels and not file names, you can enter in any 
text you like into the box. Your labels can be very descriptive such as "Trigger on High 
Speed traffic when CRC errors occur." 
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Creating a New Recording Options File 
To create a new Recording Options name: 

Step 1 Enter a comment for the new file in the Options Name field.

Step 2 Click Save.

You see the Save As window.

Step 3 Specify a filename (*.rec)

Step 4 Click Save.

Loading a Recording Options File
To load a Recording Options name: 

Step 1 Click Load to display the Open window.

Step 2 From the list of .rec files, select the one that represents your Options Name.

The options settings for that name then display.

Trace File Name & Path
Trace File Name & Path opens a Save As dialog box for saving your trace file. The 
default recording file name is data.usb for Low, Full, and High Speed recordings. 

• Click Trace File Name & Path.
You see a Save As window in which to enter the recording file name *.usb for all 
subsequent recordings.
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10.2 Recording Speed
The Misc tab settings allow you to set the speed of traffic and to configure the Analyzer 
to record On-The-Go traffic. 

• On the Go: Check this if you are tracing an On the Go device. This allows 
session request protocol detection. 

• Dual Role Devices:
• 2DRD: If both devices are Dual-Role devices, check this box to enable 

Host Negotiation Protocol (HNP) detection.
• A Dev Name: Enter a name of your choice to refer to the device that 

receives the mini-a plug.
• B Dev Name: Enter a name for the device that receives the mini-b plug.

• Assume B is 1st Host: Check this box if your scenario is one where the B 
device is acting as host when the trace is started. If the trace incorrectly 
identifies the wrong host, you can change it when viewing it by clicking on the 
host field of a packet and selecting a switch to the other host ID. 
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10.3 Events Recording Options
The Event triggering and filtering options allow you to set specific parameters for each 
Event Group. When an Event Group is selected, a field appears that allows you to select 
specific conditions within the corresponding Event Group. As details are selected, other 
Event Group details may become "grayed out" because of limited hardware resources in 
the Analyzer. Information about the resources available is displayed below the Event 
Group details. When a detail is grayed out, it is inactive and cannot be selected. If an 
Event Group remains inactive, the current version of the application or BusEngine™ does 
not support it.

• Click the Events tab on the Recording Options screen to display the Event 
Groups window: 
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Packet Identifiers
• Select Packet Identifiers under Event Groups to display the Packet 

Identifiers window:

The Packet Identifier (PID) field lists the available packet types. Select up to three packet 
types to use as a Recording Trigger. 

Token Patterns
• Select Token Patterns under Event Groups to display the Token Patterns 

window: 

Specify up to three combinations of Address/Endpoint with any of the token PIDs. They 
can be triggered on or filtered in/out. 
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Frame Patterns
• Select Frame Patterns under Event Groups to display the Frame Patterns 

window: 

Identify frame patterns you want either to filter out of a Trace View or to use as a Trigger. 
You can select either All Start of Frame packets (SOF) to be filtered out or specify the 
Frame Number of a frame to trigger on.

Device Requests
• Select Device Requests under Event Groups to display the Device 

Requests window: 

You can select one or two Device Requests for triggering or filtering.
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Data Pattern
• Select Data Pattern under Event Groups to display the Data Pattern 

window: 

Enter a Data Pattern to be triggered upon or click Edit to open a pattern editor and enter 
data on a bit-by-bit basis.

Step 1 Press the Edit button. to display a Bit-by-Bit window:

Step 2 Click your mouse on the bits within each byte that you wish to edit and enter in 
the appropriate text. 
The Mask and Match fields change to reflect your changes.
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Bus Conditions
• Select Data Pattern under Event Groups to display the Bus Conditions 

window: 

Use any combination of the listed errors as a Trigger.

Errors
• Select Errors under Event Groups to display the Errors window: 
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Use any combination of the listed errors as a Trigger.

• Bit Stuffing, Frame-Length, CRC, Pid, EOP, Short Byte checkboxes - 
Select one or more of these errors to set these as the basis for triggering or 
filtering. A Short Byte is a condition where EOP begins on a non-byte 
boundary.

• Time-out Violation - Select this checkbox and then enter in the Turn-around 
time in the text box. This value tells the Analyzer how much time should 
elapse before triggering/filtering. Clocks are 60 MHz (with a resolution of 
16.66 ns).

• Excessive Empty Frame Detection - Select this option and enter the empty 
frame count in the text box. This value tells the Analyzer how many frames 
should elapse before triggering/filtering. 

• Babble Start Violation - Select this checkbox to trigger or filter whenever the 
start of a packet occurs too late in a Frame.

• Babble End Violation (or LOA) - Select this to trigger/filter when the end of a 
packet occurs too late in a Frame. Enter a value in the EOF offset box from 1 
to 65,535 clocks to indicate the size of the offset from start of previous SOF.

• Bad Data Toggle - Select this checkbox to trigger or filter whenever a Data0, 
Data1, Data2 toggle violation occurs. 

• Select IN or OUT if you only want triggering/filtering to occur only on IN or 
OUT transactions. 

• Check Incl Reset if you want the first toggle value after a reset to be 
considered "good" regardless of the value prior to that reset. If Unchecked, 
toggle state is assumed to be preserved through the reset. 

• Select Addr and/or Endp to select Token Addresses and/or Endpoints.
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Transactions
• Select Transactions under Event Groups to display the Transactions 

window: 

Use any combination of the listed errors as a Trigger.

Data Length
• Select Data Length under Event Groups to display the Data Length 

window: 

To trigger on data length, enter a value between 0 and 1024 in the box marked Data 
Length. 
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Splits
• Select Splits under Event Groups to display the following window. 

To trigger on splits, select a split type, and endpoint type, and an address. You can also 
select FS Isoch Out when you select the Isoch endpoint type. 
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10.4 Actions Recording Options
The Actions screen serves as a means of setting Triggers, Filters (In or Out), and Counts 
for the events selected in the Events window.

Actions Window Layout
 The Actions window divides into three sections: left, center, and right.

The left section displays buttons for the events selected in the Events window. Events 
buttons tell USBMobileHS what it should look for during a recording. The number of Event 
buttons displayed depends on the number of Events selected in the Events window. If no 
Events were selected, no Event buttons are displayed.

The right side of the window displays a pair of counters called Count1 and Count2. 
Counters provide a way for setting triggers based on a passage of a certain number of 
events. When an event is linked to a counter, the counter appears below the event on the 
left side of the screen. 

The right section displays three Action buttons: Trigger, Filter Out, and Restart. Action 
buttons controls USBMobileHS’s response to Event conditions. For example, if an Error 
button is linked to a Trigger button, the Action button tells USBMobileHS to trigger when 
the error condition occurs. 

The lines that join the different buttons indicate the links between Actions and Events.
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10.5 Connecting Events to Actions
To create or edit links between Event buttons, Counters, and Action buttons, you click an 
Event button and then click a Counter or Action. By clicking an Event, an arrow connects 
the Event button to the cursor. When you click a Counter or Action button, the arrow 
becomes anchored to the selected button.

To make an event association: 

Step 1 Select one or more Events from the Events window.

Step 2 Open the Actions window.

Step 3 Click the left mouse button on an Event button such as Errors.

The elastic arrow appears.

Step 4 Point your mouse at the desired Action button.

The elastic arrow moves with the mouse pointer.

Step 5 With the pointer over an Actions button, click again the left mouse button again.

The arrow is anchored to the Action button. replaced with a black line connecting 
the Event button to the Action button.
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10.6 Connecting Counters to Events
The right side of the Actions window contains two Counter buttons marked Count1 and 
Count2. 

These counters provide a way of triggering after a number of events have passed, such 
as "Trigger after the 20th IN packet." 

When an event is linked to a counter, the counter appears under that event on the left 
side of the Actions window. Counters have blue dots in their top left corner that provide 
access to pop-up menus. The menus provide the means of setting the counter value. The 
counter can be set between 1 and 65,535. 

To connect an event to a counter: 

Step 1 Open the Event window and select an Event.

An Event button appears in the Actions window. 

Step 2 Open the Actions window.

The window displays an Event button that is connected to the Trigger button on 
the right via a line.

Step 3 Click the Event button. 

An arrow connects the Event button to the mouse pointer. 

Step 4 Click one of the two counters.

The Event automatically connects to the Counter button and then connects to the 
Trigger button. 
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Step 5 Click the blue dot in top left corner of your selected counter.

A pop-up menu opens to allow you to configure the counter.

Step 6 Choose Change Counter Value.

The Input Counter Value dialog box opens.

Step 7 Set the counter to a value, then click OK.

The dialog box closes, and the Counter button displays your selection.

Setting Multiple Conditions with Counters
You can create multiple event conditions by linking two counters to two or more events.

Linking Two Events to Two or More Counters - If an Event is linked to Count1 and a 
second event is linked to Count2, it creates an OR statement. This statement reads 
"Trigger when Count1 OR Count2 has reached their specified values."

This example reads "Trigger when Count1 has counted nine Out packets or Count2 has 
counted nine In packets."
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10.7 Using Action Buttons
The right section of the Actions window displays three Action buttons labeled Trigger, 
Filter Out/In, and Restart. 

Trigger
The Trigger button enables event triggering. 

Restart
Restart causes counters to restart counting when a certain event occurs. When Restart 
is used, the screen has at least two links: one between an Event and the Restart button, 
and a second between an Event, Counter and an Action button.

The screenshot below gives an example. The screen below reads "Look for IN and Out 
packets. When 10 OUT packets, trigger. However, if an IN packet occurs during the 
count, restart the count."
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Filter Out/In
The Filter In/Out button causes events to be filtered in or out of the recording. Filter 
Out/In toggles between:

• Filter In records ONLY those packets related to the specified event.
• Filter Out records all packets EXCEPT those related to the specified event.

Note:  Only events from the Token, Frame Event, Device Request, and Transaction 
Groups can be used to filter a recording.

To filter in or out Token, Frame Event, Device Request, and/or Transaction Group events 
from a recording, 

Step 1 Click the blue dot on Filter Out. (Note: the button may say Filter In depending 
on the last action specified.)

You see the Filter Polarity menu:

Step 2 Select Filter In. 

The button changes to read Filter In.

10.8 Saving Recording Options
To complete your Recording Options settings, use the features at the bottom of the 
Recording Options screen. These features remain the same no matter which of the 
three Recording Options screens you are working in.

• Click Save to save the currently specified Recording Options for use in future 
recording sessions. Any file name can be specified, though use of the .rec is 
recommended; if no extension is specified, .rec is added by default.

• Click Load to load a previously saved *.rec file, thus restoring a previous set 
of Recording Options.

• The Save as Default function is equivalent to the Save function, specifying 
the file name default.rec. Whenever you start up the Analyzer, it 
automatically loads the default.rec file if one exists.

• Click OK to apply any changes and close this dialog box.
• Click Cancel to cancel any immediate changes you have made and exit the 

Recording Options menu.
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10.9 Recording Bus Data
Note:  If you have inserted any event triggers, be sure to select Event Trigger 

under the General tab in the Recording Options dialog box. 

To start recording USB traffic after the appropriate Recording Options have been set: 

Step 1 Select Start under Record on the Menu Bar.

OR

Click  on the Tool Bar.

Your recording session can continue until it has finished naturally, 
 
or you may need to stop manually by clicking  on the Tool Bar, depending on how 
you set the Recording Options.

To manually stop recording: 

Step 1 Select Stop under Record on the Menu Bar.

OR

Click  on the Tool Bar.

Click  again during the uploading to upload only a portion of the recorded memory. 

Note:  The manual Stop Recording feature is primarily of use when recording 
low-speed traffic, which can take a long time to fill the recording buffer.

When the recording session is finished, the bus traffic is saved to the hard drive as a file 
named data.usb or whatever name you assign as the default filename.

To save a current recording for future reference: 

Step 1 Select Save As under File on the Menu Bar.

OR

Click  on the Tool Bar.

You see the standard Save As screen.

Step 2 Give the recording a unique name and save it to the appropriate directory.
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Chapter 11:  Updates
From time to time as modifications are made to the USBMobileHS™ Hi-Speed USB 
Analyzer, it is necessary to update the Analyzer for optimal performance. 

11.1 Software, Driver, and BusEngine Revisions
The Readme.txt file on the first installation disk and in the installed directory gives 
last-minute updates about the current release. 

Once the Analyzer has completed the self diagnostics and is connected to the PC, you 
can check the latest revision of the software and BusEngine™ by selecting About 
USBMobileHS… from the Help menu. 

About USBMobileHS details revisions of the following software and hardware:

• USBMobileHS Software Version
• USBMobileHS Driver Version
• BusEngine Version
• Unit Serial Number

Note:  When contacting LeCroy for technical support, please have available all the 
revisions reported in the About USB USBMobileHS window.
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11.2 Software Updates
When a new software release is available, it is posted on the Support page of the LeCroy 
website at www.lecroy.com/support.html.
To update the software: 

Step 1 In the About USBMobileHS screen, verify which version of USBMobileHS 
Software you are currently running.

Step 2 Find the latest released software version on the LeCroy website under Support.
If you are running the latest version of the software, no further action is 
needed. 

If you are not running the latest version, continue to Step 3.

Step 3 Download the Zip files from the website. 

Step 4 Unzip the files into your choice of directory.

Step 5 Click Start, then Run, and browse to where you unzipped the files.

Step 6 Select the program named Setup and click Open.

Step 7 Click OK to run the Setup and begin the installation.

Step 8 Follow the on-screen instructions to complete the installation.

Step 9 Read the Readme file for important information on changes in the release.

11.3 BusEngine and Driver Updates
The Bus Engine and driver updates are done automatically during software installation. 
No user interaction is necessary or possible.
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Appendix A:  Legacy Script Decoding
Earlier LeCroy USB Analyzers used .REQ and .DSC script files to decode class and 
vendor requests. 

• .REQ stands for Requests.
• .DSC stands for Descriptors.

This method uses fixed definitional structures. 

For legacy script decoding, LeCroy provides .req files for the following requests and 
classes:

• Standard Requests (standard.req)
• Hub Class (hub.req)
• HID Class (hid.req)
• Printer Class (printer.req)
• Communications Class (communication.req)
• Audio Class (audio.req)
• Bluetooth USB HCI commands and events (bluetooth.req)
• Vendor Request definition file (vendor.req)

Note:  .req files are no longer used in LeCroy USB Analyzers.  
In addition, .req files are not compatible with the UWBTracer 
application. 
The new script decoding for LeCroy USB Analyzers uses 
Script Decoder version .dec files. 
.dec files are compatible with the UWBTracer application. 
It is highly recommended that you use the new Script Decoder 
mechanism.  
For information about .dec files and the new script decoding, see 
“Class and Vendor Definition Files” on page 75.

If you must add your own .req file for a Class or Vendor Request, do the following: 

Step 1 Use the Notepad application to create and edit your own Request Definition file 
(for example, my_vendor_commands.req).

Note:  To learn to write such a file, review the Request (.req) files provided by 
LeCroy.

Step 2 Add the name of your Request file to the request.lst file.

Step 3 Click Setup. The decoding menu in the Class/Vendor List appears.
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Appendix B:  China Restriction of Haz-
ardous Substances Table

The following tables are supplied in compliance with China's Restriction of Hazardous 
Substances (China RoHS) requirements: 
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How to Contact LeCroy

Limited Hardware Warranty
So long as you or your authorized representative ("you" or "your"), 
fully complete and return the registration card provided with the 
applicable hardware product or peripheral hardware products 
(each a "Product") within fifteen days of the date of receipt from 
LeCroy or one of its authorized representatives, LeCroy warrants 
that the Product will be free from defects in materials and workmanship for a period of three years 
(the "Warranty Period"). You may also complete your registration form via the internet by visiting 
http://www.catc.com/support/register/. The Warranty Period commences on the earlier of the date 
of delivery by LeCroy of a Product to a common carrier for shipment to you or to LeCroy's 
authorized representative from whom you purchase the Product.

What this Warranty Does Not Cover

This warranty does not cover damage due to external causes including accident, damage during 
shipment after delivery to a common carrier by LeCroy, abuse, misuse, problems with electrical 
power, including power surges and outages, servicing not authorized by LeCroy, usage or 
operation not in accordance with Product instructions, failure to perform required preventive 
maintenance, software related problems (whether or not provided by LeCroy), problems caused by 
use of accessories, parts or components not supplied by LeCroy, Products that have been modified 
or altered by someone other than LeCroy, Products with missing or altered service tags or serial 
numbers, and Products for which LeCroy has not received payment in full.

Coverage During Warranty Period

During the Warranty Period, LeCroy or its authorized representatives will repair or replace 
Products, at LeCroy's sole discretion, covered under this limited warranty that are returned directly 
to LeCroy's facility or through LeCroy's authorized representatives.

Type of Service Contact
Call for technical support… US and Canada: 1 (800) 909-2282

Worldwide: 1 (408) 727-6600
Fax your questions… Worldwide: 1 (408) 727-6622
Write a letter… LeCroy 

Customer Support 
3385 Scott Blvd. 
Santa Clara, CA 95054

Send e-mail… support@catc.com
Visit LeCroy’s web site… http://www.lecroy.com/
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How to Obtain Warranty Service

To request warranty service, you must complete and return the registration card or register via the 
internet within the fifteen day period described above and report your covered warranty claim by 
contacting LeCroy Technical Support or its authorized representative. 

You can reach LeCroy Technical Support at 800-909-7112 or via email at support@catc.com. You 
may also refer to the LeCroy website at http://www.lecroy.com for more information on how to 
contact an authorized representative in your region. If warranty service is required, LeCroy or its 
authorized representative will issue a Return Material Authorization Number. You must ship the 
Product back to LeCroy or its authorized representative, in its original or equivalent packaging, 
prepay shipping charges, and insure the shipment or accept the risk of loss or damage during 
shipment. LeCroy must receive the Product prior to expiration of the Warranty Period for the 
repair(s) to be covered. LeCroy or its authorized representative will thereafter ship the repaired or 
replacement Product to you freight prepaid by LeCroy if you are located in the continental United 
States. Shipments made outside the continental United States will be sent freight collect.

Please remove any peripheral accessories or parts before you ship the Product. LeCroy does not 
accept liability for lost or damaged peripheral accessories, data or software.

LeCroy owns all parts removed from Products it repairs. LeCroy may use new and/or reconditioned 
parts, at its sole discretion, made by various manufacturers in performing warranty repairs. If 
LeCroy repairs or replaces a Product, the Warranty Period for the Product is not extended.

If LeCroy evaluates and determines there is "no trouble found" in any Product returned or that the 
returned Product is not eligible for warranty coverage, LeCroy will inform you of its determination. 
If you thereafter request LeCroy to repair the Product, such labor and service shall be performed 
under the terms and conditions of LeCroy's then current repair policy. If you chose not to have the 
Product repaired by LeCroy, you agree to pay LeCroy for the cost to return the Product to you and 
that LeCroy may require payment in advance of shipment.
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General Provisions

THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE 
ADDITIONAL RIGHTS THAT VARY BY JURISDICTION. LECROY'S RESPONSIBILITY FOR 
DEFECTS IN MATERIALS AND WORKMANSHIP IS LIMITED TO REPAIR AND REPLACEMENT 
AS SET FORTH IN THIS LIMITED WARRANTY STATEMENT. EXCEPT AS EXPRESSLY STATED 
IN THIS WARRANTY STATEMENT, LECROY DISCLAIMS ALL EXPRESS AND IMPLIED 
WARRANTIES FOR ANY PRODUCT INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED 
WARRANTIES OF AND CONDITIONS OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, AND ANY WARRANTIES THAT MAY ARISE FROM ANY COURSE OF 
DEALING, COURSE OF PERFORMANCE OR TRADE USAGE. SOME JURISDICTIONS MAY 
NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THE 
PRECEDING LIMITATION MAY NOT APPLY TO YOU.

LECROY DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES SET FORTH IN THIS 
LIMITED WARRANTY STATEMENT OR FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES 
INCLUDING, WITHOUT LIMITATION, ANY LIABILITY FOR THIRD PARTY CLAIMS AGAINST 
YOU FOR DAMAGES, PRODUCTS NOT BEING AVAILABLE FOR USE, OR FOR LOST DATA OR 
SOFTWARE. LECROY'S LIABILITY TO YOU MAY NOT EXCEED THE AMOUNT YOU PAID FOR 
THE PRODUCT THAT IS THE SUBJECT OF A CLAIM. SOME JURISDICTIONS DO NOT ALLOW 
THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE 
PRECEDING EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU.

The limited warranty on a Product may be transferred for the remaining term if the then current 
owner transfers ownership of the Product and notifies LeCroy of the transfer. You may notify LeCroy 
of the transfer by writing to Technical Support at LeCroy, 3385 Scott Blvd., Santa Clara, CA 95054 
USA or by email at: support@catc.com. Please include the transferring owner's name and address, 
the name and address of the new owner, the date of transfer, and the Product serial number.
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Index
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.dec files 75
.dsc files 125
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A
A Dev Name checkbox 107
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Bit Order option 37
Bit Order section 71
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bits 34
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BT .dec file 78
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BusEngine
updates 123

buttons
actions 116, 120
Bus Utilization 99
navigator 50
toolbars 23

Bytes box 104
Bytes menu 58

C
Cable Based Association Framework .dec file 78
cables

connection 13
length 11

CAPI Control Model .dec file 75
CATC Trace 4

set marker 32
software 1

Change Counter Value command 119
Channel

search 61
chirps

hiding 38
class definition files 75, 125
Class Request

decode 90
Class request, decode 90
Class/Vendor decoding 79
Class/Vendor Decoding field 79
Class/Vendor Decoding Groups menu 80
Class/Vendor Endpoint Decoding

field 81
menu 82

Class/Vendor endpoint RPipes decoding 85, 87
classes 125
Clear Marker command 33
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clock

speed 8
collapse

data fields 35
Collapse All Data Fields command 36
Collapse Data menu 36
Collapse transactions 42
Collapse transfers 44
collapsed mode 66
color

display 8

Color section 69
Color/Format/Hiding tab 68
colors

Display Options 69
comment field 52
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editing 52
Comments attribute 52
Communication Device Subclass/EEM .dec file 75
communication.req file 125
Communications and CDC Control .dec file 75
Communications Device Class (CDC) Data 77
Communications Device Class (CDC) Data .dec file 
77
Compare Endpoint Data command 18
compatibility 9
complex search 62
components 7

physical 5
configuration 8
Configuration Name option 67
connecting

counters to events 118
events to actions 117

connections 8
connectors 9, 13
Continue option 25
Control Transfer 88
Control Transfer field 88
convert.usb file 17
Counter button 118
Counters

changing values 119
counters 2, 116

connect to events 118
setting multiple conditions 119

counting
restart 120

CRC error 113
Custom

colors 69
tab 70

Customize
command 22
dialog box 22

D
data block

viewing 37
Data Block dialog box 37
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data field
bits 37

Data Field menu 37
data fields

collapse 35
expand 35
pop-up menus 36

data formats 70
data length

search for 58
Data Length event group 114
Data option 18, 67
Data Pattern event group 111
data types 69
data.usb file 14, 106, 122
date format 70
Decode

decoding options 79
decode

class request 90
endpoint 81, 91
endpoint DWA RPipes 87
endpoint RPipes 85
general options for requests 88
hub status 91
layout 92
protocol-specific fields 45
request recipient 79
Request rRPipe 84, 86
requests 88, 89
standard request 89
vendor requests 90

Decode ... Request command 90
Decode as ... Endp command 91
Decode Standard Request command 89
decoded transactions, viewing 41
decoded transfers 44
decoder files 75
decoding

assigning 79
refresh 88

default settings 13
default.opt options file 73
default.rec file 121
Device Management Model 75
Device Requests 88
Device Requests event group 110
Device Wire Adapter .dec file 78
Device Wire Adapter Segment View 47
Device Wire Adapter Transfer View 47
devices

hiding 38
dimensions 9
Direct Line Control Model .dec file 75
direction

search 26, 63
Direction field 81
directory

installation 11
disk space 8
display

configuration name 67
resolution 8
windows 18

Display Options 6
Color/Format/Hiding tab 68
colors 69
command 65
factory values 67
formats 70
General 66
hiding 71
level hiding 72
loading 73
saving 73
window 65

dot
blue 119

driver updates 124
Dual Role devices 107
DWA RPipes

endpoints 87

E
Edit Comment command 52
Edit comment for trace file window 52
Edit Marker Comment

command 33
window 33

Edit Marker Comment window 32
editing

comment 52
data patterns 111
marker 33

elastic arrow 117
e-mail 129
empty frame 113
Enable Tips option 66
Endp checkbox 113
Endp field 81
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decoding 81
toggle 66

Endpoint RPipes
dialog box 85, 87
tab 85, 87

Endpoints
tab 81

endpoints
decoding 91
DWA RPipes 87
RPipes 85

Endpoints dialog box 81
environment 9
EOF Offset box 113
EOP error 113
Error Report option 67
Error Summary report 95
errors 67

searching for 57
summary 95
types 113

Errors event group 112
Errors menu 57
Errors option 51
Esc key 25
Ethernet Networking Control Model .dec file 75
Event Groups window 108
Event Trigger recording type 104
events

actions 116
connecting to counters 118
connection to actions 117
event groups 108
filtering 108
linking 119
Recording Options 108
trigger 104
triggering 2, 108

Events Group box 62
Events tab 108
Events window 116
Excessive Empty Frame Detection error 113
exclusion search 63
expand

data fields 35
Expand All Data Fields command 36
Expand Data menu 36
Expand Packet Data Fields by default option 66
Expand Script-Based Decoded Info by default op-
tion 66

Expand transactions 42
Expand transfers 44
expanded mode 66
Export command 18

F
F1 help 21
features

product 5
trace 15, 31

Fields option 67
file

USBMobileHS.inf 12
File Information report 94
File menu 18
files

.dec 75

.dsc 125

.opt 73

.rec 105, 121

.req 125
editing comment for trace 52
information 94
script 75, 125
trace filename 106

Filter In action button 121
Filter Out action button 121
Filter Polarity menu 121
filtering 2, 5, 121

events 108
Find command 62
Find Next command 63
firmware updates 123
Flush option 25
Fonts and Colors options 101
Fonts option 67
fonts, changing 67
Format option 37
Format section 71
formats

date and time 70
Display Options 70
number 70
text 70

Frame Number field 110
Frame Patterns event group 110
Frame-Length error 113
Full Buffer/Upload Selection option 25
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General tab

Display Options 66
Recording Options 104

Go To
menu 55
search 55

Go to
Marker search 54
Packet/Transaction/Transfer search 54
Trigger search 53

Graph Areas menu 102
graphs 102
Grid Lines options 100
Grid on Top command 100
Group and Color column 69

H
hard disk space 8
hardware 9

installation 12
Help menu 21
HID .dec file 76
hid.req file 125
Hidden checkbox 71
hiding

chirps 38
devices 38
Display Options 71
levels 72
NAKs 38
SOF 66
SOF packets 38
toolbars 21

Hierarchy Lines option 66
HNP protocol 1, 60
host

compatibility 9
requirements 8

Host field 79
Host Negotiation Protocol 3, 60, 107
Host Wire Adapter .dec file 78
Host Wire Adapter Segment View 46
Host Wire Adapter Transfer View 47

hosts
Host Negotiation Protocol 60
with a B plug 60
with an A plug 60

hot keys 28
Hub .dec file 76
hub.req file 125
humidity 9
HUT .dec file 76
HWA address field 84

I
Import command 18
IN checkbox 113
Incl Reset checkbox 113
initial USB recording 13
Input Counter Value dialog box 119
Install Software command 11
installation 7

directory 11
hardware 12
software 11

Interface Association Descriptor .dec file 78
Internet browser 8
intersection search 63
Invalid Data field 70

K
Keep Across Recordings checkbox 80
keyboard

shortcuts 28
keys

shortcuts 28

L
layout 92

actions window 116
Layout command 92
Legend 51
letter 129
Level Hiding tab 72
lines

hierarchy 66
linking

events 119
LOA error 113
Load command 73, 106, 121
logical objects 48
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Manual Trigger recording type 104
Map DWA RPipe to Class/Vendor Decoding com-
mand 86
Map Endpoint to Class/Vendor Decoding command 
81
markers

clearing 33
editing 33
Go To 54
setting 32

Mask field 111
Mass Storage .dec file 76
Match field 111
Media Transfer Protocol 48
memory 9

requirements 105
menus 18

graph areas 102
pop-up 66
pull-down 18
view settings 100

mini A-B plugs 11
Misc tab

recording options 107
miscellaneous shortcuts 30
Mobile Direct Line Model 75
mode

collapsed 66
expanded 66

monitor
resolution 8

Monitor .dec file 76
More option 60
MTP 48
Multi-Channel Control Model .dec file 75

N
NAKs, hiding 38
name

Recording Options settings 105
navigation 50, 67

shortcuts 28
tools 27

Navigation Bar checkbox 50
Navigator 50
Navigator bar 50
Navigator option 67
No Decoding option 80

number format 70

O
OBEX Model 75
object handles 48
object transfers 48
On the Go

adaptor 7
searching 60

On the Go checkbox 107
On-The-Go

support 1
On-the-Go

menu 60
On-The-Go support 3
operating range 9
operating system 8
opt files 73
options file 73
Options Name field 105
Orient Horizontally command 100
Orient Vertically command 100
origin

search 63
OTG 3

shortcuts 30
OUT checkbox 113
overview 1

software 17

P
Packet # field 32
Packet Identifiers event group 109
Packet menu 32
packet too late 113
packets

display level 67
Go To 54
hiding SOF 38
identifiers 109
searching for IDs 56
view features 15

Packets to .CSV option 18
Packets to Device Emulation Traffic Generation 
Text File option 18
Packets to Host Traffic Generator Text File option 
18
Packets to Text option 18
Partial Upload button 26
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percentages, post triggering 105
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tion 77
Physical .dec file 76
physical components 5
Physical Interface .dec file 76
physical memory 105
Picture Transfer Protocol 48
Picture Transfer Protocol .dec file 77
PID

shortcuts 29
Pid error 113
PIMA 77
Plug and Play instructions 12
plugs

mini A-B 11
Point of Sale Devices .dec file 76
pop-up menus 66

data field 36
pop-up tool tips 38
ports

testing 11
position of trigger 105
post-triggering percentages 105
Power .dec file 76
power consumption 9
Pre/Post Trigger option 51
Printer .dec file 76
printer.req file 125
processors 8
product

features 5
specifications 9

program
startup 17

Progress Indicator 24
protocols 60
protocol-specific fields, decode 45
PTP 48
PTP .dec file 77
PTP Object 48
PTP Session 49
PTP Transaction 48
pull-down menus 18

Q
questions 129

R
RAM 8
raw bits

viewing 34
Raw Bits View 34
Readme.txt file 6, 123
Recently Used Ranges option 51
Recipient field 79
Record function 25
Record menu 19
recording

activity 26
bus data 122
Event Trigger 104
first 13
Manual

Trigger 104
memory 9
progress 24
snapshot 104
speed 107
start 122
status 25
stop 122
type 104

Recording Options 5
command 103
creating file 106
default settings 13
events 108
file 106
General 104
loading 106, 121
menu 103
options name 105
Save 121
speed 107

Recording Progress Indicator 24
red bar 32
refresh 88
Refresh Decoding for this Trace File command 88
Report menu 19, 93
reports 93
Request DWA RPipes

tab 86
Request Recipient and Endpoints dialog box 79
Request RPipes 84, 86

dialog box 84, 86
tab 84

request.lst file 125



Index USBMobileHS User Manual

140 LeCroy Corporation

requests 88, 125
requirements

PC 8
Reset All button 22
resolution

display 8
Restart action button 120
restarting 2
Restore Factory Presets option 67
Right click cell context menu option 66
RPipe field 84, 86
RPipes 84, 86

endpoints 85

S
save

Display Options 73
recording options 121
trace files 106

Save As dialog box 106
Script Decoder

files 78
Manual 78

Script Decoding language 78
script files 75, 125
Scripts directory 75
SCSI/Bulk Protocol .dec file 76
search

complex 62
Direction 63
direction 26, 63
exclusion 63
feature 53
Find 62
intersection 63
menu 53
options 53
Origin 63
status 26
union 63

Search menu 19
Session Request Protocol 3, 60
sessions 49
Set Marker command 32
Set range near packet number option 51
Set Range to Whole Trace option 51
setting

marker in trace 32
settings

default 13

SETUP
field 88
transaction 88

Setup
menu 19
program 12

Setup program 124
Sho rt Byte error 113
shortcuts 28
Show Markers command 100
Show Per Line option 37
Show Plumb Line command 100
Show Raw Bits command 34
Smart Card .dec file 77
Smart Card Class 77
Snapshot recording type 104
SOF Hiding 66
SOF packets, hiding 38
software

installation 11
overview 17
revisions 123
updates 124

specification
USB 8

specifications 9
speed

recording 107
Split Transaction View 43
Splits event group 115
SRP protocol 1, 60
standard.req file 125
Start button 122
start packet too late 113
starting

software 17
status

recording 25
search 26

Status bar 24
Status options 100
Still Imaging Class .dec file 76
Stop

button 25, 122
option 25

Stop Recording 122
storage range 9
summary

error 95
traffic 97

support 129
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system 7

architecture 8
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technical support 129
Telephone Control Model .dec file 75
test ports 11
text format 70
Tile Horizontally command 100
Tile Vertically command 100
Time-out Violation error 113
Timestamp At The Beginning option 66
Timestamp field 66
timing 67
Timing and Bus Usage Calculator screen 96
Timing Calculations report 96
Timing Calculator option 67
toggle violation 66, 113
Token Patterns event group 109
toolbars

button descriptions 23
page 22
resetting 21
tab 22

tooltips 18, 38, 66
trace

first recording 14
Navigator 50
reading 31
recording 13
set marker 32
view features 15, 31
viewing 31
viewing level 67

Trace File Name & Path command 106
trace files

edit comment 52
filename 106

Trace Navigator 50
Trace Viewing Level option 67
traffic

recording 13
summary 97

Traffic Summary option 67
Traffic Summary report 97
Transaction View 39
Transactions

event group 114

transactions 48
decoded 41
decoding protocols 45
expanded/collapsed 42
Go To 54
split view 43

Transfer View 43
transfers

decode protocols 45
decoded 44
expanded/collapsed 44
Go To 54

Trigger action button 120
Trigger Position command 105
triggering 5
triggers 2, 5

Event 104
events 108
Go To 53
Manual 104
Trigger action button 120
trigger position 105
using errors for 113

Truncate Data Fields command 104
truncation 5, 104
Turn-around time 113
Type field 79
Types of Traffic option 51

U
UFI(floppy)/CBI Protocol .dec file 76
union search 63
Universal Serial Bus Specification 8, 90
updates 123

software 124
upload

partial 26
stopping 25

USB
recording traffic 13
test ports 11

USB Device Request menu 88
USB Device Requests 88
USB Implementers Forum 8, 90
USB specification 8
USB-IF 8, 90
USBMobileHS.inf file 12
User-Defined Find Events screen 62
UWB .dec file 78
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VBus pulsing 1
vendor definition files 75, 125
vendor.req file 125
versions 123
Video Class .dec file 77
Video CONTROL .dec file 77
Video INTERFACE COLLECTION .dec file 77
Video STREAMING .dec file 77
view

data block 37
decoded transactions 41
decoded transfers 44
raw bits 34, 37
split transaction 43
transaction 39
transfer 43
Wire Adapter Segment 46, 47
Wire Adapter Transfer 47, 48, 49

View ... Fields Dialog Layout dialog box 92
View Data Block command 37
View Fields for ... Class Requests text box 90
View Fields for ... Endp text box 91
View Fields for Standard Request text box 89
View menu 20

options 21
View Settings

button 100
menu 100

Viewing Level 67

W
warranty 9

coverage 129
limited 129
period 129
provisions 131
service 130

website 124, 129
weight 9
window layout, actions 116
Window menu 20
Wire Adapter .dec file 78
Wire Adapter Multifunction Peripheral programming 
interface 78
Wireless Controller .dec file 78
Wireless Handset Control Model 75
Wrap command 27
Wrap option 66

Z
Zoom In command 27
Zoom Level option 66
Zoom Out command 27
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